
SYSTÈMES NUMÉRIQUES MULTIFONCTIONS COULEUR / 
SYSTÈMES NUMÉRIQUES MULTIFONCTIONS

Guide de e-Filing



©2016, 2017 TOSHIBA TEC CORPORATION Tous droits réservés
Conformément aux lois régissant le copyright, il est interdit de reproduire le présent manuel sous une forme quelconque 
sans la permission écrite préalable de Toshiba TTEC. 



Préface    3

Préface

Merci d'avoir choisi la gamme de systèmes multifonctions noir et blanc ou la gamme de systèmes multifonctions 
Noir & Couleur TOSHIBA. 
Ce manuel explique comment utiliser les fonctions e-Filling de ce système. 
Lisez ce manuel avant d'utiliser les fonctions du système.

 Pour lire ce manuel

 Symboles utilisés dans ce manuel

Dans ce manuel, certains points importants sont signalés au moyen des symboles ci-dessous. Prenez connaissance de 
ces points importants avant d'utiliser le système.

 Public cible de ce manuel

Ce manuel est destiné à l'ensemble des utilisateurs et des administrateurs.

 Nom du modèle et de la série utilisés dans ce manuel

Dans ce manuel, chaque nom de modèle est remplacé par le nom de série présenté ci-dessous.

 Equipement en option

Pour voir les options disponibles, reportez-vous au Guide de prise en main rapide.

 Captures d'écran présentées dans ce manuel

 Dans ce manuel, le système d'exploitation Windows 10 est utilisé à des fins explicatives pour décrire les écrans et 
les procédures de fonctionnement sous Windows.

Lors d’une impression avec le toner bleu effaçable de la série e-STUDIO5008LP, seuls le papier ordinaire de format 
standard et le papier recyclé (64 - 80 g/m2, 17 - 20 lb. Bond) peuvent être utilisés afin de réutiliser le papier 
efficacement. De plus, les fonctions de finition telles que l'agrafage, la perforation ou le pliage central ne peuvent 
pas être exécutées.

Indique une situation potentiellement dangereuse qui, si elle n'est pas évitée, peut 
entraîner le décès, des blessures graves, des dommages importants ou l'incendie du 
système ou de son environnement.

Indique une situation potentiellement dangereuse qui, si elle n'est pas évitée, peut 
provoquer des blessures mineures ou légères, des dégâts partiels au niveau du système 
ou du matériel environnant, ou encore des pertes de données.

Fournit des informations auxquelles vous devez porter une attention particulière lors de 
l'utilisation de ce système.

Fournit des informations auxquelles vous devez porter une attention particulière lors de 
l'utilisation de ce système.

Pages décrivant des éléments en rapport avec l'action en cours. Consultez-les en 
fonction de vos besoins.

Nom du modèle
Nom de série utilisé dans ce 

manuel

e-STUDIO2000AC/2500AC Série e-STUDIO5005AC

e-STUDIO2505AC/3005AC/3505AC/4505AC/5005AC

e-STUDIO2008A/2508A/3008A/3508A/4508A/5008A Série e-STUDIO5008A

e-STUDIO5506AC/6506AC/7506AC Série e-STUDIO7506AC

e-STUDIO5508A/6508A/7508A/8508A Série e-STUDIO8508A

e-STUDIO3508LP/4508LP/5008LP Série e-STUDIO5008LP

AVERTISSEMENT

ATTENTION

Conseil
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 Les informations des captures d'écran sont susceptibles de varier selon votre modèle et l'utilisation du système 
(par exemple, selon le statut des options installées, la version du système d'exploitation et les applications).

 Les écrans d'illustration utilisés dans ce manuel correspondent à un papier de format A/B. Si vous utilisez du papier 
de format LT, l'écran ou l'ordre des boutons présenté dans les illustrations peut être différent de celui de votre 
équipement.

 Abréviations utilisées dans ce manuel

Dans ce manuel, les termes "Chargeur de documents avec double numérisation" (DSDF) et "Chargeur retourneur 
automatique de documents" (RADF) sont collectivement désignés par "Chargeur automatique de documents" (ADF).

 Marques

Pour plus d'informations concernant les marques, reportez-vous aux Informations de sécurité.
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Cette section présente les fonctionnalités et fonctions e-Filing.

Fonctionnalités e-Filing ......................................................................................................8

Fonctions e-Filing............................................................................................................. 10
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0.Fonctionnalités e-Filing

L’utilitaire e-Filing est installé sur le périphérique de stockage interne du système. Il permet de stocker des 
documents en vue de les imprimer, de les modifier ou tout simplement de les gérer.
Cette section décrit la fonction de stockage de documents de l'utilitaire e-Filing.

 Boîte publique
La boîte publique est un répertoire e-Filing créé par défaut. Tous les utilisateurs ayant accès à cette boîte, il 
convient d'y stocker des documents partagés dont n'importe quel utilisateur peut avoir besoin. Dans la mesure où 
la boîte publique est incorporée au système, vous ne pouvez pas la renommer, la supprimer ni en créer une 
nouvelle.

 Zone utilisateur
La zone utilisateur est un répertoire e-Filing que chaque utilisateur peut créer. Ce type de zone peut être protégé 
par mot de passe. Il permet à des utilisateurs spécifiques, tels qu'un administrateur, de stocker des documents 
confidentiels. Vous pouvez également créer une zone utilisateur sans pour autant la protéger par un mot de passe. 
Dans ce cas, cette zone utilisateur sera accessible à tous les utilisateurs au même titre que la boîte publique.
Vous pouvez créer jusqu'à 200 zones utilisateur.

 Dossiers
Vous pouvez créer des dossiers dans chaque boîte. Néanmoins, un seul niveau de dossiers peut être créé dans 
chaque boîte. Vous ne pouvez donc pas créer de sous-dossiers.
Vous pouvez créer jusqu'à 100 dossiers par boîte.

 Documents
Les documents peuvent être stockés dans une boîte ou un dossier e-Filing par le biais des méthodes suivantes
(Jusqu'à 400 documents peuvent être stockés dans une boîte ou un dossier, et un document peut contenir jusqu'à 
200 pages.)

- Copie et enregistrement dans e-Filing
- Numérisation de documents et enregistrement dans e-Filing
- Impression depuis un ordinateur client et enregistrement dans e-Filing
- Les fax/fax Internet reçus sont enregistrés dans e-Filing via les fonctions de transfert.
- Les fax/fax Internet reçus sont enregistrés dans e-Filing via les fonctions de boîtes aux lettres de transfert.

Documents enregistrés lors 
d'opérations de copie/scan

Dossier

Boîte utilisateur

Dossier

Ordinateur clientTableau de bord
Documents enregistrés 
lors d'opérations d'impression 
(via le pilote d'impression)

Documents enregistrés lors 
d'opérations de réception de 
fax/fax Internet

Boîte publique

Tous les utilisateurs

Utilisateurs spécifiés 
(ou administrateurs)
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 Pour utiliser les caractéristiques de la fonction Fax, il faut installer l'unité fax.
 En fonction de la quantité de données stockées dans e-Filing, il peut s'écouler un certain temps entre le moment où 

l'équipement est mis sous tension et celui où e-Filing est prêt à être utilisé.

Conseil

 Pour plus d'informations sur les fonctions de transfert, reportez-vous au Guide de TopAccess.
 Pour plus d'informations sur les fonctions de boîte aux lettres de transfert, reportez-vous au Guide de la fonction 

fax (GD-1370) et au Guide de TopAccess.
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0.Fonctions e-Filing

 P.10 "Fonctions disponibles depuis votre système"
 P.11 "Fonctions disponibles depuis un ordinateur client"

 Fonctions disponibles depuis votre système
Vous trouverez ci-après la liste des fonctions e-Filing que vous pouvez utiliser avec l'écran tactile. Pour plus 
d'informations sur leur fonctionnement, reportez-vous aux références données ci-après.

 Impression de documents

Les fonctions suivantes permettent d'imprimer des documents enregistrés dans e-Filing.

 Pour imprimer tout un document
 P.14 "Impression de l'intégralité d'un document"

 Pour imprimer quelques pages seulement à des fins de test
 P.17 "Test d'impression"

 Stockage de documents

Les fonctions suivantes permettent d'enregistrer des documents dans e-Filing.

 Pour copier et stocker des documents
 P.19 "Copier et stocker vers e-Filing"

 Pour numériser et stocker des documents
 P.24 "Numérisation vers e-Filing"

 Suppression de documents

Pour supprimer des documents dans e-Filing
 P.27 "Suppression de documents"

 Gestion des zones et des dossiers utilisateur

Les fonctions suivantes permettent de gérer les zones et dossiers utilisateur dans e-Filing. L'écran tactile ne permet 
pas de créer ou de modifier des dossiers dans les zones. Pour créer des dossiers, vous devez recourir à un ordinateur 
client.

 Pour créer des zones utilisateur
 P.29 "Création de zones utilisateur"

 Pour modifier le nom et le mot de passe d'une zone utilisateur
 P.30 "Modification des zones utilisateur"

 Pour supprimer des zones et dossiers utilisateur
 P.31 "Suppression des zones et des dossiers utilisateur"
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 Fonctions disponibles depuis un ordinateur client
Vous trouverez ci-après la liste des fonctions e-Filing que vous pouvez utiliser avec un ordinateur client (utilitaire Web 
e-Filing). Pour plus d'informations sur leur fonctionnement, reportez-vous aux références données ci-après.

L'utilitaire Web e-Filing est uniquement compatible avec le système d'exploitation Windows. Il ne peut pas être utilisé 
sur les ordinateurs exécutant un autre système d'exploitation (Mac OS, etc.).

 Gestion des zones et des dossiers utilisateur

Les fonctions suivantes permettent de gérer les zones et dossiers utilisateur dans e-Filing.

 Pour créer des zones et dossiers utilisateur
 P.40 "Création de répertoires et de dossiers utilisateur"

 Pour supprimer des zones et dossiers utilisateur
 P.43 "Suppression de répertoires et de dossiers utilisateur"

 Pour modifier (renommer et changer les propriétés) des zones et dossiers utilisateur
 P.44 "Renommer des répertoires et des dossiers utilisateur"
 P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur"

 Gestion de documents

Les fonctions suivantes permettent de gérer des documents stockés dans e-Filing.

 Pour afficher des fichiers images sous forme de vignettes ou dans une liste
 P.50 "Affichage des documents"

 Pour renommer des documents
 P.51 "Renommer des documents"

 Pour supprimer des documents
 P.53 "Suppression de documents"

 Pour imprimer des documents (document entier/test d'impression)
 P.54 "Impression de documents"

 Pour stocker des documents lors d'une opération d'impression
 P.59 "Stockage de documents avec le pilote d'impression"

 Pour archiver des documents
 P.62 "Archivage de documents"

 Pour envoyer des documents sous forme de messages électroniques
 P.66 "Envoi d'un message électronique"

 Modification de documents

Les fonctions suivantes permettent de modifier des documents enregistrés dans e-Filing.

 Pour afficher les propriétés des documents et des pages
 P.76 "Affichage des propriétés des documents et des pages"

 Pour copier/couper des pages d'un document et les coller dans un autre
 P.77 "Copie de pages d'un document à un autre"

 Pour copier/couper des pages d'un document et les enregistrer dans un nouveau document
 P.82 "Copie des pages d'un document dans une boîte ou un dossier"

 Pour supprimer des pages d'un document
 P.85 "Suppression de pages dans un document"

 Pour insérer des pages vierges dans un document
 P.87 "Insertion d'une page vierge dans un document"

 Pour déplacer des pages au sein d'un document afin de modifier l'ordre des pages
 P.90 "Déplacement de pages dans un document"

 Pour déplacer des documents d'une zone ou d'un dossier à l'autre
 P.93 "Déplacement de documents"

 Pour copier l'intégralité d'un document et l'insérer dans un autre document
 P.95 "Fusion de documents"
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Conseil

 Vous pouvez importer des documents e-Filing sur un ordinateur client à l'aide du pilote TWAIN et du Téléchargeur 
de fichiers.

 Vous pouvez sauvegarder ou restaurer des documents dans l'e-Filing, ainsi que divers paramètres de ce dernier, à 
l'aide de l'utilitaire de sauvegarde/restauration e-Filing.



2.OPERATIONS REALISEES SUR LE SYSTEME

Cette section décrit les fonctions e-Filing que vous pouvez utiliser à l'aide du tableau de bord du système.

Impression de documents .................................................................................................14
Impression de l'intégralité d'un document........................................................................................................14
Test d'impression ................................................................................................................................................17

Stockage de documents ....................................................................................................19
Copier et stocker vers e-Filing.............................................................................................................................19
Numérisation vers e-Filing ..................................................................................................................................24

Annulation de travaux ......................................................................................................26
Annulation de travaux en cours ..........................................................................................................................26
Suppression de travaux d'impression ................................................................................................................26

Suppression de documents ...............................................................................................27

Gestion des zones et des dossiers utilisateur ......................................................................29
Création de zones utilisateur ..............................................................................................................................29
Modification des zones utilisateur ......................................................................................................................30
Suppression des zones et des dossiers utilisateur.............................................................................................31
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0.Impression de documents

Vous pouvez imprimer des documents stockés dans l'e-Filing grâce à l'écran tactile de votre système.
 P.14 "Impression de l'intégralité d'un document"
 P.17 "Test d'impression"

 Impression de l'intégralité d'un document
Vous pouvez imprimer un document dans son intégralité.

1 Dans l'écran d'accueil, appuyez sur [e-Filing].

2 Sélectionnez la boîte contenant le document à imprimer.

Vous pouvez également spécifier le numéro de boîte (3 chiffres).

 Saisie de mot de passe
Si un mot de passe est défini pour la boîte sélectionnée, l'écran de saisie du mot de passe apparaît. Saisissez le 
mot de passe, puis appuyez sur la touche [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir la boîte, vous ne pourrez pas vous connecter 
pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte est 
verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

3 Si le document se trouve dans un dossier, sélectionnez le dossier et appuyez sur la touche [Ouvrir 
(Open)].

Cette opération est inutile si le document n'est pas stocké dans un dossier.
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4 Sélectionnez le document. Pour modifier les paramètres d'impression, appuyez sur [Paramètres 
(Settings)]. Sinon, appuyez sur [Imprimer (Print)] pour lancer l'impression.

Si vous appuyez sur [Paramètres (Settings)], passez à l'étape 5.
Si vous appuyez sur [Imprimer (Print)], l'impression démarre. Si vous souhaitez supprimer un travail pour 
annuler l'impression, reportez-vous à la section suivante.
 P.26 "Annulation de travaux"

Conseil

Appuyez sur  pour afficher les images vignettes des documents. Sélectionnez l'image souhaitée et appuyez 

sur [Ouvrir (Open)] pour afficher son contenu. Appuyez sur  pour revenir à la liste.
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5 Modifiez les paramètres comme il convient.
Pour les séries e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC, e-STUDIO8508A

Pour la série e-STUDIO5008LP

Vous pouvez paramétrer l'impression comme décrit ci-dessous. Définissez ces derniers comme il convient. Ces 
paramétrages sont identiques à ceux effectués en mode de copie. Pour plus d'informations sur la procédure à 
suivre, reportez-vous au Guide de copie.

1. Sélectionnez le chargeur de papier. Cependant, si le format de papier sélectionné est différent du format de 
papier actuellement chargé, la sélection sera annulée et le papier sera sélectionné de façon automatique.

2. Saisissez le nombre de copies à imprimer.
3. Sélectionnez le mode d'impression recto verso. Si vous ne voulez pas imprimer sur les deux faces du papier, 

sélectionnez [Recto (1 Side)] dans le menu.
4. Sélectionnez le mode de finition. Les options de finition disponibles varient en fonction du type de finisseur 

installé.
5. Sélectionnez le bac de réception. Cette touche est disponible uniquement si le Finisseur (en option) est 

installé.
6. Définissez la position et la largeur de la marge.
7. Définissez la position de la date et de l'heure à imprimer.
8. Définissez la position du numéro de page à imprimer.
9. Sélectionnez le toner à utiliser pour l'impression. Cette option n'est disponible qu'avec la série 

e-STUDIO5008LP.

1 6 7 8

3 4 5

2

1 6

3 4 5

2

9

8

7
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6 Appuyez sur [Imprimer (Print)].

Si vous souhaitez supprimer un travail pour annuler l'impression, reportez-vous à la section suivante.
 P.26 "Annulation de travaux"

 Test d'impression
Vous pouvez imprimer certaines pages du document à des fins de test.

1 Dans l'écran d'accueil, appuyez sur [e-Filing].

2 Sélectionnez la boîte ou le dossier contenant les documents à imprimer.

L'étape concernant la sélection de boîte/dossier a été volontairement omise dans la mesure où cette étape est 
identique à celle décrite dans la procédure Impression de l'intégralité d'un document.
 P.14 "Impression de l'intégralité d'un document"

3 Sélectionnez le document à imprimer, puis appuyez sur [Test d'impr. (Test print)].

Si vous possédez la série e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC ou e-STUDIO8508A, passez à 
l'étape 5.

Conseil

Appuyez sur  pour afficher les images vignettes des documents. Sélectionnez l'image souhaitée et appuyez 

sur [Ouvrir (Open)] pour afficher son contenu. Appuyez sur  pour revenir à la liste.
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4 Sélectionnez cette option pour spécifier le toner à utiliser pour l'impression.

 [Bleu effaçable (Erasable Blue)] : les originaux sont imprimés avec toner de bleu effaçable.

 [Noir (Black)] : les originaux sont imprimés en noir et blanc.

Conseil

Cette option n'est disponible qu'avec la série e-STUDIO5008LP.

5 Indiquez les numéros de page appropriés dans [Première page (First Page)] et [Dernière page 
(Last Page)], puis sur [Imprimer (Print)].

 Si vous appuyez sur la touche [Effac. (Clear)] du tableau de bord, la valeur saisie dans le champ actuellement 
sélectionné peut être supprimée.

 Pour imprimer toutes les pages du document, appuyez sur [Toutes les pages (All Pages)].

Si vous souhaitez supprimer un travail pour annuler l'impression, reportez-vous à la section suivante.
 P.26 "Annulation de travaux"
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0.Stockage de documents

Vous pouvez stocker des documents dans l'e-Filing grâce à l'écran tactile de ce système.
 P.19 "Copier et stocker vers e-Filing"
 P.24 "Numérisation vers e-Filing"

 Stockez vos documents confidentiels dans une zone utilisateur protégée par un mot de passe.
 Jusqu'à 400 documents peuvent être stockés dans une boîte ou un dossier, et un document peut contenir jusqu'à 

200 pages.
 La capacité maximale disponible dans le dossier partagé diffère selon le modèle ou environnement d'exploitation 

que vous utilisez. Vous pouvez vérifier l'espace total disponible dans le dossier partagé et dans e-Filing dans 
l'onglet [Périphérique (Device)] de TopAccess.

 Le système e-Filing n'a pas été conçu pour stocker des documents de façon permanente. Supprimez les documents 
dès qu'ils sont obsolètes. 
 P.27 "Suppression de documents"

 Les formats des originaux suivants n'étant pas correctement détectés, vous devez les sélectionner manuellement 
lorsque vous les placez :

- Originaux très transparents (transparents ou papier calque, par exemple)
- Originaux entièrement sombres ou comportant des bords sombres
- Originaux de format non standard (journaux, magazines, etc.)

Pour plus d'informations, reportez-vous au Guide de la préparation du papier.

Conseil

 Pour stocker des documents dans des zones utilisateur et des dossiers, vous devez créer ces derniers à l'avance.
 P.29 "Création de zones utilisateur" (Utilisation sur ce système)
 P.40 "Création de répertoires et de dossiers utilisateur" (Utilisation sur un ordinateur client)

 Vous pouvez définir la durée de stockage des documents dans la fenêtre des propriétés des zones utilisateur. Les 
documents seront supprimés une fois cette période dépassée.
 P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur" (Utilisation sur un 
ordinateur client)

 Copier et stocker vers e-Filing
Vous pouvez copier et stocker des documents dans e-Filing. Les documents e-Filing peuvent être copiés et stockés 
simultanément.

 Les documents dont les formats de papier sont affichés ci-dessous ne peuvent pas être stockés dans e-Filing.

- Papier personnalisé
- Format papier non standard (bac de dérivation)

 Les documents archivés par copie vers e-Filing pourront être imprimés. En revanche, ils ne pourront pas être 
importés sous forme d'image sur un ordinateur client. L'importation avec une qualité d'image optimale nécessite 
un archivage par numérisation vers e-Filing.
 P.24 "Numérisation vers e-Filing" 

1 Mettez les originaux en place et définissez le mode de copie.
Pour plus d'informations sur la mise en place des originaux et le paramétrage du mode de copie, reportez-vous 
au Guide de la préparation du papier / Guide de Copie.

Si vous choisissez le mode "Twincolor Copy (Copie 2)" ou "Monochrome (Monochrome)" dans l'onglet [Image], 
vous ne pouvez pas stocker les documents dans le système e-Filing. Ces modes ne permettent pas non plus de 
stocker des documents tout en les copiant.
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2 Appuyez sur [Stockage (Storage)] dans l'écran de copie.

3 Appuyez sur [Stock. vers e-Filing (Store to e-Filing)].

4 Appuyez sur [Boite/Doss. (Box/Folder)].
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5 Sélectionnez le répertoire où vous souhaitez stocker les données.

Vous pouvez également spécifier le numéro de boîte (3 chiffres).

 Saisie de mot de passe
Si un mot de passe est défini pour la boîte sélectionnée, l'écran de saisie du mot de passe apparaît. Saisissez le 
mot de passe, puis appuyez sur la touche [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir la boîte, vous ne pourrez pas vous connecter 
pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte est 
verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

6 Pour stocker les documents dans le répertoire sélectionné, appuyez sur [OK].

 Stockage dans un dossier
Sélectionnez le dossier et appuyez sur [Ouvrir (Open)] pour en afficher le contenu. Pour stocker les documents 
dans le dossier sélectionné, appuyez sur [OK].
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7 Modifiez le nom du document, puis appuyez sur [OK].

 Renommer des documents
Saisissez le nom du document (64 caractères maximum) dans [Nom document (Document name)] et appuyez 
sur [OK].

Conseil

 Une chaine de caractères composée de "DOC", année, mois et date s'affiche par défaut. Ce format peut être 
modifié dans Top Access. Pour plus d'informations, reportez-vous au Guide de TopAccess.

 Si un nom identique a déjà été enregistré, un numéro de série (-001, -002…) sera ajouté automatiquement à la 
fin du nom du fichier et enregistré.

8 Appuyez sur [Oui (Yes)] pour stocker et imprimer le document. Pour stocker le document sans 
l'imprimer, appuyez sur la touche [Non (No)].

9 Appuyez sur la touche [DEMARRER (START)].
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Copie de l'original suivant (copie)
En fonction de la façon dont l'original est chargé, l'écran vous invitant à confirmer la copie de l'original suivant 
peut s'afficher. Répétez la procédure ci-dessous autant de fois que nécessaire. Une fois la numérisation de la 
dernière page de l'original terminée, appuyez sur [Job fini (Job Finish)].

 Si les originaux sont copiés via la vitre, placez l'original suivant puis appuyez sur [Copie suivante (Next copy)] 

pour commencer la numérisation.

 Lorsque l'original est placé dans l'ADF en mode d'alimentation simple, la numérisation ne commence que 

lorsque l'original suivant est chargé. Aucune intervention de l'utilisateur n'est nécessaire.
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 Numérisation vers e-Filing
Vous pouvez numériser et stocker des documents dans e-Filing. Lorsque vous importez un original sous la forme 
d'une image sur un ordinateur client, il est conseillé de stocker le document à l'aide de la fonction de numérisation 
vers e-Filing.

1 Placez l'original du document à enregistrer puis paramétrer le mode Scan si nécessaire. 
Pour plus d'informations sur la mise en place des originaux et le paramétrage du mode de scan, reportez-vous au 
Guide de la préparation du papier / Guide du Scan.

2 Appuyez sur [e-Filing].

3 Sélectionnez le répertoire ou le dossier où vous souhaitez stocker les documents. Modifiez le nom 
du document, puis appuyez sur [OK].

L'étape concernant la sélection de répertoire/dossier et le changement du nom d'un document a été 
volontairement omise dans la mesure où cette étape est identique à celle décrite dans la procédure Copier et 
stocker vers e-Filing.
 P.19 "Copier et stocker vers e-Filing"

Pour utiliser cette fonctionnalité, la fonction de numérisation est requise.
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4 Appuyez sur [Scan].

Le nombre acceptable de travaux de scan réservés varie selon les paramètres. Si les travaux réservés dépassent 
le nombre correspondant, un message vous informant que le nombre maximum de réservations a été dépassé 
apparaît Dans ce cas, attendez que les travaux de numérisation réservés aient été traités ou supprimez ceux qui 
sont inutiles.
 P.26 "Suppression de travaux d'impression"

Numérisation de l'original suivant (scan)

 Lorsque l'original est placé sur la vitre ou que vous appuyez sur la touche [Continuer (Continue)] lors de la 

numérisation d'originaux placés dans le chargeur automatique de documents, l'écran vous invitant à 

confirmer la numérisation de l'original suivant apparaît.

 Dans ce cas, placez le nouvel original et appuyez sur [Scan] pour le numériser. Suivez cette procédure autant 

de fois que nécessaire. Lorsque tous les originaux sont numérisés, appuyez sur [Job fini (Job Finish)].

 Vous pouvez modifier les paramètres de scan en appuyant sur [Param. de num. (Scan Setting)].

 Vous pouvez annuler la réservation des données numérisées en appuyant sur [Annul job (Job Cancel)].
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0.Annulation de travaux

 P.26 "Annulation de travaux en cours"
 P.26 "Suppression de travaux d'impression"

 Annulation de travaux en cours
Si vous souhaitez annuler l'impression ou la numérisation en cours d'un document, appuyez sur [Stop].

 Suppression de travaux d'impression
Suivez la procédure décrite ci-après pour arrêter l'impression ou la numérisation d'un document (suppression d'un 
travail d'impression).

1 Appuyez sur [Etat trav. (Job Status)].

2 Dans le menu relatif à l'état des travaux, affichez la liste des travaux.

3 Sélectionnez le travail à supprimer, puis appuyez sur [Supprimer (Delete)].

4 L'écran de confirmation de la suppression apparaît. Appuyez sur la touche [Supprimer (Delete)].
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0.Suppression de documents

Vous pouvez supprimer des documents dans e-Filing en utilisant l'écran tactile de ce système.

Le système e-Filing n'est pas conçu pour sauvegarder des documents indéfiniment. Supprimez les documents dès 
qu'ils sont obsolètes.

Conseil

La suppression d'un dossier ou d'un répertoire entraîne systématiquement la suppression des documents qu'ils 
contiennent.
 P.31 "Suppression des zones et des dossiers utilisateur" (Utilisation sur ce système)
 P.43 "Suppression de répertoires et de dossiers utilisateur" (Utilisation sur un ordinateur client)

1 Dans l'écran d'accueil, appuyez sur [e-Filing].

2 Sélectionnez la boîte ou le dossier contenant le document à supprimer.

L'étape concernant la sélection de répertoire/dossier a été volontairement omise dans la mesure où cette étape 
est identique à celle décrite dans la procédure Impression de l'intégralité d'un document.
 P.14 "Impression de l'intégralité d'un document"

3 Sélectionnez le document à supprimer, puis appuyez sur [Supprimer (Delete)].

Conseil

Appuyez sur  pour afficher les images vignettes des documents. Sélectionnez l'image souhaitée et appuyez 

sur [Ouvrir (Open)] pour afficher son contenu. Appuyez sur  pour revenir à la liste.



2.OPERATIONS REALISEES SUR LE SYSTEME

28    Suppression de documents

4 Appuyez sur [Supprimer (Delete)] pour supprimer le document sélectionné.

Vous pouvez annuler la suppression du document sélectionné en appuyant sur la touche [Annuler (Cancel)].
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0.Gestion des zones et des dossiers utilisateur

Vous pouvez gérer les zones et dossiers utilisateur de l'e-Filing à l'aide de l'écran tactile de ce système.
 P.29 "Création de zones utilisateur"
 P.30 "Modification des zones utilisateur"
 P.31 "Suppression des zones et des dossiers utilisateur"

Conseil

Les dossiers peuvent être créés et modifiés par le biais d'un ordinateur client.
 P.40 "Création de répertoires et de dossiers utilisateur"
 P.44 "Renommer des répertoires et des dossiers utilisateur"
 P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur"

 Création de zones utilisateur
Vous pouvez créer jusqu'à 200 zones utilisateur.

1 Dans l'écran d'accueil, appuyez sur [e-Filing].

2 Appuyez sur l'onglet [Param. répert. (Box Setting)], sélectionnez une touche vierge numérotée 
de "001" à "200", puis appuyez sur [Config. (Setup)].

De plus, vous pouvez directement spécifier le numéro de boîte (3 chiffres).

3 Entrez le nom de la boîte et le mot de passe dans les champs [Nom boîte (Box name)], [Mot de 
passe (Password)] et [Retaper mdp (Retype password)], puis appuyez sur [OK].

 Saisie du nom de la boîte
Saisissez le nom de la boîte (32 caractères maximum) dans [NOM BOITE (BOX NAME)] et appuyez sur [OK]. Les 
caractères ci-dessous, codés sur un seul octet, ne peuvent pas être utilisés. 
" # % & ' = | { } * < > ? [ ] ; : / \ ,
N'insérez ni espace ni point au début ou à la fin du nom. Si vous saisissez l'un de ces caractères, un message 
vous informant que le caractère utilisé n'est pas correct apparaît.

 Saisie d'un mot de passe
Vous pouvez créer une zone utilisateur sans définir de mot de passe. Si vous appuyez sur [OK] sans saisir de 
mot de passe, vous créez une zone utilisateur et une boîte publique auxquelles tous les utilisateurs peuvent 
accéder.
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Si le mot de passe saisi ne respecte pas la police de mot de passe, un message d'avertissement apparaît. 
Saisissez le mot de passe correct.
Pour plus d'informations sur la police de mot de passe, reportez-vous au Guide de TopAccess.

Modification des zones utilisateur
Vous pouvez modifier le nom et le mot de passe d'une zone utilisateur.

1 Dans l'écran d'accueil, appuyez sur [e-Filing].

2 Appuyez sur l'onglet [Param. répert. (Box Setting)], sélectionnez le répertoire utilisateur à 
modifier, puis appuyez sur [Modifier (Edit)].

De plus, vous pouvez directement spécifier le numéro de boîte (3 chiffres).

 Saisie de mot de passe
Si un mot de passe est défini pour la boîte sélectionnée, l'écran de saisie du mot de passe apparaît. Saisissez le 
mot de passe, puis appuyez sur la touche [OK].

Conseil

Le mot de passe de l'administrateur peut également être utilisé ici.

3 Changez les champs [Nom boîte (Box name)] / [MDP (Password)] / [Retaper mdp (Retype 
password)] si nécessaire, puis appuyez sur [OK].

L'étape concernant le paramétrage des champs [Nom répert. (Box Name)] / [Mot de passe (Password)] / 
[Ressaisir MDP (Retype Password)] a été volontairement omise dans la mesure où cette étape est identique à 
celle décrite dans la procédure Création de répertoires utilisateur.
 P.29 "Création de zones utilisateur"



2.OPERATIONS REALISEES SUR LE SYSTEME

Gestion des zones et des dossiers utilisateur    31

O
P

ER
A

T
IO

N
S

 R
EA

LIS
EES

 S
U

R
 LE S

YS
T

EM
E

 Suppression des zones et des dossiers utilisateur
Vous pouvez supprimer des zones et des dossiers utilisateur.

La suppression d'un dossier ou d'une zone entraîne systématiquement la suppression des dossiers et documents 
qu'ils contiennent.

1 Dans l'écran d'accueil, appuyez sur [e-Filing].

2 Suivez la procédure décrite ci-après pour supprimer des dossiers et des zones utilisateur.
 Suppression de zones utilisateur

Appuyez sur l'onglet [Param. répert. (Box Setting)], sélectionnez le répertoire utilisateur à supprimer, puis 
appuyez sur [Supprimer (Delete)].

L'étape concernant la sélection de zones utilisateur a été volontairement omise dans la mesure où cette étape 
est identique à celle décrite dans la procédure Modification des zones utilisateur.
 P.30 "Modification des zones utilisateur"

 Suppression de dossiers
Affichez l'onglet [Imprimer (Print)], sélectionnez le dossier à supprimer, puis appuyez sur [Supprimer (Delete)].

L'étape concernant la sélection de dossiers a été volontairement omise dans la mesure où cette étape est 
identique à celle décrite dans la procédure Impression de l'intégralité d'un document.
 P.14 "Impression de l'intégralité d'un document"
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3 Appuyez sur [Supprimer (Delete)] pour supprimer le document/la boîte sélectionné(e).

Vous pouvez annuler la suppression du répertoire/du dossier sélectionné en appuyant sur la touche [Annuler 
(Cancel)].
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0.Avant d'utiliser l'utilitaire Web e-Filing

Avant d'utiliser l'utilitaire Web e-Filing, vérifiez les éléments suivants sur votre ordinateur.
 P.34 "Navigateurs Web pris en charge"
 P.34 "Procédure de paramétrage de Microsoft Edge"

L'utilitaire Web e-Filing est uniquement disponible pour les ordinateurs disposant du système d'exploitation 
Windows. Vous ne pouvez pas l'utiliser sur un ordinateur fonctionnant sous Mac OS ou sous un autre système 
d'exploitation.

 Navigateurs Web pris en charge
L'utilitaire Web e-Filing fonctionne avec les navigateurs des systèmes d'exploitation Microsoft Windows suivants :

 Microsoft Edge
 Internet Explorer 9.0 ou version ultérieure
 Firefox 38 ou version ultérieure
 Chrome 45 ou supérieur
 La résolution d'écran minimale requise pour ces navigateurs est de 800 x 600.
 Désactivez la fonction de blocage des fenêtres contextuelles du navigateur Web. Pour plus d'informations sur le 

paramétrage de la fonction de blocage des fenêtres contextuelles, reportez-vous à la rubrique d'aide du navigateur 
Web utilisé.

 Lors de l'utilisation de Microsoft Edge, désactivez le paramètre [Bloquer les fenêtres pop-ups (Block pop-ups)] en 
cliquant sur [OFF]. Sélectionnez également le paramètre [Ne pas bloquer les cookies (Don't block cookies)]. Pour 
des instructions sur le paramétrage de Microsoft Edge, reportez-vous à la procédure ci-après.
 P.34 "Procédure de paramétrage de Microsoft Edge"

 Dans Internet Explorer, l'option Confidentialité doit être paramétrée sur Moyenne. Ne sélectionnez ni la valeur 
"Haute", ni la valeur "Bloquer tous les cookies".

 Procédure de paramétrage de Microsoft Edge
Lorsque vous utilisez Microsoft Edge, veillez à effectuer le paramétrage indiqué ci-après.

1 Sélectionnez  (Plus d'actions) > [Paramètres (Settings)] > [Afficher les paramètres avancés 
(View advanced settings)].
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2 Désactivez le paramètre [Bloquer les fenêtres pop-ups (Block pop-ups)] en cliquant sur [OFF].

3 Sélectionnez également [Ne pas bloquer les cookies (Don't block cookies)] pour le paramètre 
[Cookies].

4 Quittez Microsoft Edge et relancez-le avant d'accéder à l'e-Filing.

Quittez Microsoft Edge une fois l'utilitaire Web e-Filing ouvert. Pour vous déconnecter de l'utilitaire Web e-Filing 
en mode utilisateur, cliquez sur le lien Déconnexion et quittez Microsoft Edge.
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0.Mise en route à partir de l'utilitaire Web e-Filing

Cette section explique comment démarrer et quitter l'utilitaire Web e-Filing. La procédure de lancement de l'utilitaire 
varie selon que vous êtes connecté en tant qu'utilisateur ou administrateur système.

 P.36 "Connexion en tant qu'utilisateur"
 P.100 "Connexion en tant qu'administrateur système"

 Connexion en tant qu'utilisateur
Il existe deux façons d'accéder à l'utilitaire Web e-Filing :

 Cliquez sur le lien de l'utilitaire Web e-Filing du site Web TopAccess.
 Saisissez l'URL de l'utilitaire Web e-Filing dans le champ d'adresse de votre navigateur Web.

L'URL de l'utilitaire Web e-Filing est : http://[adresse IP]/?MAIN=EFILING
La partie [adresse IP (IP address)] correspond à l'adresse IP de ce système. Vous pouvez également utiliser le nom DNS 
de ce système.
Par exemple, l'adresse IP du système est 192.168.1.2
http://192.168.1.2/?MAIN=EFILING
Par exemple, le nom DNS du système est mfp-00000236.
http://mfp-00000236/?MAIN=EFILING

Conseil

 Les utilisateurs peuvent lancer l'utilitaire Web e-Filing pour utiliser ses fonctions.
 L'accès à l'utilitaire Web e-Filing expire au terme du délai défini pour la minuterie de session dans les paramètres 

Web généraux sous TopAccess.
 Pour utiliser les fonctions d'administrateur de l'utilitaire Web e-Filing, l'utilisateur doit se connecter en tant 

qu'administrateur système.
 P.100 "Connexion en tant qu'administrateur système"

A propos du paramètre de gestion des utilisateurs
Si la fonction de gestion des utilisateurs est activée, la page de connexion s'affiche lorsque vous accédez à l'URL 
de l'utilitaire Web e-Filing. Dans ce cas, veuillez saisir vos identifiants d'authentification (nom d'utilisateur et mot 
de passe) pour accéder à la page principale de l'utilitaire Web e-Filing.

Si vous entrez plusieurs fois un mot de passe d'authentification incorrect pour vous connecter au système 
multifonctions TOSHIBA, vous ne pourrez pas vous connecter pendant un certain temps car cela sera considéré 
comme un accès non autorisé.
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0.Menus de l'utilitaire Web e-Filing

L'interface de l'utilitaire Web e-Filing comprend trois onglets situés dans la partie supérieure droite du navigateur 
Web : l'onglet [Documents], l'onglet [Préférences (Preferences)] et l'onglet [Administration].

Ils permettent d'afficher et de manipuler vos documents, de définir des préférences d'affichage et d'exécuter des 
fonctions d'administration.
 P.37 "Onglet [Documents]"
 P.39 "Onglet [Préférences (Preferences)]"
À droite des onglets principaux se trouve le lien Connexion permettant de se connecter en tant qu'administrateur 
système.
 P.39 "Lien Connexion"

Onglet [Documents]
L'onglet [Documents], qui apparaît par défaut, est accessible par tous les utilisateurs. Il se compose d'un volet 
Dossiers et documents, d'une barre de menus et d'un volet Contenu.

1. Volet Document
Le volet document s'affiche comme interface utilisateur de type Explorateur. Ce volet vous permet de 
sélectionner les dossiers et documents cibles.
Dans le volet Document, les icônes suivantes s'affichent en fonction des éléments.

- Icônes des répertoires

 : Cette icône indique que le répertoire est fermé.

 : Cette icône indique que le répertoire est ouvert.

 : Cette icône indique que le répertoire fermé est protégé par un mot de passe.

 : Cette icône indique que le répertoire ouvert est protégé par un mot de passe.
- Icônes des dossiers

 : Cette icône indique que le dossier est fermé.

 : Cette icône indique que le dossier est ouvert.

4

1

2 3
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- Icônes des documents

   : Cette icône désigne un document archivé par le biais d'une impression. Lorsqu'elle s'affiche avec un 
fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond de 
couleur bleue, le document est en cours de modification.

   : Cette icône désigne un document archivé par le biais d'une numérisation. Lorsqu'elle s'affiche avec 
un fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond de 
couleur bleue, le document est en cours de modification.

   : Cette icône désigne un document archivé par le biais d'une copie. Lorsqu'elle s'affiche avec un fond 
de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond de couleur 
bleue, le document est en cours de modification.

   : Cette icône désigne un document archivé lors d'une opération de fax par le biais de la fonction de 
boîte aux lettres, de transfert de fax reçus ou de transfert de fax Internet reçus.
Lorsqu'elle s'affiche avec un fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle 
s'affiche avec un fond de couleur bleue, le document est en cours de modification.

   : Cette icône désigne un document obtenu par fusion de plusieurs documents. Lorsqu'elle s'affiche 
avec un fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond 
de couleur bleue, le document est en cours de modification.

2. Barre de menus
Vous pouvez activer la fonction e-Filing depuis la barre de menus. Elle contient les menus Fichier, Modifier, 
Visualiser et Mise en page.

3. Barre d'outils
La barre d'outils contient les icônes relatives aux fonctions suivantes : Envoyer un e-mail, Enregistrer, Test 
d'impression, Couper, Copier, Coller, Début, Précédent, Suivant et Fin. Elles vous offrent un accès rapide aux 
fonctions cibles.

 : Cliquez sur cette icône pour envoyer les documents sélectionnés par message électronique.

 : Cliquez sur cette icône pour enregistrer le document. Elle n'est active que lorsque le document est cours de 
modification.

 : Cliquez sur cette icône pour effectuer un test d'impression.

 : Cliquez sur cette icône pour couper les pages ou documents sélectionnés.

 : Cliquez sur cette icône pour copier les pages ou les documents sélectionnés.

 : Cliquez sur cette icône pour coller les éléments copiés.

 : Cliquez sur cette icône pour afficher les premiers éléments du volet Contenu.

 : Cliquez sur cette icône pour afficher les précédents éléments du volet Contenu.

 : Cliquez sur cette icône pour afficher les éléments suivant immédiatement ceux affichés dans le volet 
Contenu.

 : Cliquez sur cette icône pour afficher les derniers éléments du volet Contenu.

4. Volet Contenu
Le volet Contenu affiche les documents ou pages en cours de traitement. Il vous permet de modifier l'état du 
document puis de l'imprimer et de l'éditer. Pendant que vous travaillez sur votre document, son état et les 
touches de contrôle correspondantes s'affichent.

Conseil

Pour plus d'informations sur ces boutons, reportez-vous à la section suivante :
 P.75 "Edition des pages de vos documents"
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Onglet [Préférences (Preferences)]
L'onglet [Préférences (Preferences)] est accessible par tous les utilisateurs. Il permet de définir le mode d'affichage du 
document et le nombre de vignettes à l'écran.

1. Affichage par défaut du document
Vous pouvez choisir le mode d'affichage Vignettes ou Liste, qui est conservé jusqu'à ce que vous sélectionniez 
une autre option dans le menu Affichage. Le mode Vignettes est défini par défaut.

2. Chargement x vignettes par affichage.
Utilisez la liste déroulante pour sélectionner le nombre de vignettes à afficher par écran : 4, 8 ou 12. La valeur par 
défaut est 8.

3. Afficher la barre de progression.
Cochez cette case pour afficher la barre de progression lorsque vous copiez, coupez et collez des documents et 
des pages, ou encore lorsque vous supprimez des pages et enregistrez des documents.

4. [Enregistrer (Save)]
Cliquez sur ce bouton pour appliquer les nouveaux paramètres.

5. [Réinitialiser (Reset)]
Cliquez sur ce bouton pour restaurer les paramètres par défaut.

 Lien Connexion
Le lien Connexion situé près des onglets principaux permet de se connecter en tant qu'administrateur système.
 P.100 "Connexion en tant qu'administrateur système"
Vous pouvez exécuter les fonctions d'administration à partir de l'onglet [Administration] qui apparaît une fois que 
vous êtes connecté en tant qu'administrateur système.

1
2
3

4

5
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0.Gestion des répertoires et des dossiers utilisateur

L'utilitaire Web e-Filing fournit deux types de répertoire : le répertoire public et le répertoire utilisateur. Chaque 
utilisateur peut créer son propre répertoire utilisateur dans lequel il peut également créer un niveau de dossiers.
Cette section explique comment effectuer les opérations suivantes :
 P.40 "Création de répertoires et de dossiers utilisateur"
 P.43 "Suppression de répertoires et de dossiers utilisateur"
 P.44 "Renommer des répertoires et des dossiers utilisateur"
 P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur"

Conseil

Pour plus d'informations sur le répertoire public et le répertoire utilisateur, reportez-vous à la section suivante :
 P.8 "Fonctionnalités e-Filing"

 Création de répertoires et de dossiers utilisateur
Chaque utilisateur peut créer son propre répertoire utilisateur et, si nécessaire, le protéger à l'aide d'un mot de passe.
 P.40 "Création de répertoires utilisateur"
 P.41 "Création de dossiers"

 Création de répertoires utilisateur

Il est possible de créer jusqu'à 200 répertoires utilisateur et de protéger chacun d'eux à l'aide d'un mot de passe.

Conseil

Vous pouvez également créer des zones utilisateur à partir de l'écran tactile. Pour plus d'informations sur la création 
de zones utilisateur à partir de l'écran tactile, reportez-vous à la page suivante :
 P.29 "Création de zones utilisateur"

1 Sélectionnez "e-Filing" dans le volet Document de l'onglet [Documents], puis [Nouvelle boîte 
(New Box)] dans le menu [Fichier (File)].

La fenêtre Nouveau répertoire apparaît.

2 Définissez les propriétés du répertoire et terminez l'opération.
 [N° de la boîte (Box Number)] : sélectionnez un numéro de boîte.

Les utilisateurs ne peuvent pas sélectionner des numéros de répertoire existants dans la case "N° de 
répertoire". Seuls les numéros de répertoires non définis apparaissent dans cette liste.

 [Nom de la boîte (Box Name)] : saisissez le nom de la boîte.
Les noms des boîtes peuvent être composés de caractères ASCII à l'exception des suivants : 
\ / < > " % & = ' ; : * ? | # [ ] { }.
N'insérez pas d'espace ni de point au début ou à la fin du nom. Le nom d'un répertoire peut comporter au 
maximum 32 caractères.
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 [Mot de passe de la boîte (Box Password)] / [Retaper mdp (Retype Password)] : pour protéger cette boîte, 
entrez un mot de passe dans l'un de ces champs.

Le répertoire utilisateur créé s'affiche dans le volet Document.

Conseil

Les utilisateurs peuvent paramétrer les propriétés avancées de chaque répertoire, par exemple la durée de 
conservation des documents et les fonctionnalités de notification par e-mail.
 P.46 "Modification des propriétés des répertoires"

 Création de dossiers

Il est possible de créer jusqu'à 100 dossiers par répertoire.

 Un seul niveau de dossiers peut être créé par répertoire. Vous ne pouvez donc pas créer de sous-dossiers dans les 
dossiers.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte dans laquelle vous 
souhaitez créer un dossier.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].
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3 Sélectionnez [Fichier (File)] > [Nouveau dossier (New Folder)].

La fenêtre Nouveau dossier apparaît.

4 Saisissez le nom du dossier puis cliquez sur [OK].

Le dossier créé s'affiche sous la boîte sélectionnée dans le volet Document.

Les noms de dossier sont composés de caractères ASCII, à l'exception des suivants : 
\ / < > " % & = ' ; : * ? | # [ ] { }. 
N'insérez pas d'espace ni de point au début ou à la fin du nom. Un nom de dossier peut comporter au maximum 
64 caractères.
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 Suppression de répertoires et de dossiers utilisateur
Il est possible de supprimer des répertoires et des dossiers utilisateur.

 Il est possible de supprimer les dossiers contenus dans la boîte publique. En revanche, vous ne pouvez pas 
supprimer la boîte publique elle-même.

 La suppression d'un dossier ou d'une zone utilisateur entraîne également la suppression des documents qu'ils 
contiennent.

Conseil

 Lorsque le répertoire est protégé par un mot de passe, ce dernier est demandé avant toute suppression. Les 
utilisateurs disposant des droits d'administration peuvent supprimer tous les répertoires et dossiers utilisateur à 
l'aide de leur mot de passe.

 Vous pouvez également supprimer des zones utilisateur à partir de l'écran tactile. Pour plus d'informations sur la 
suppression de zones utilisateur à partir de l'écran tactile, reportez-vous à la page suivante :
 P.31 "Suppression des zones et des dossiers utilisateur"

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte contenant les dossiers que 
vous souhaitez supprimer.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Pour supprimer une zone utilisateur, sélectionnez [Modifier (Edit)] > [Supprimer (Delete)]. Pour 
supprimer un dossier, cochez les dossiers que vous souhaitez supprimer, puis sélectionnez 
[Modifier (Edit)] > [Supprimer (Delete)].

La boîte de dialogue du message de confirmation apparaît.
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Vous pouvez également supprimer un dossier en le sélectionnant dans le volet Document, puis en sélectionnant 
[Modifier (Edit)] > [Supprimer (Delete)]. Dans ce cas, vérifiez qu'aucun document n'est sélectionné dans le volet 
Contenu. Si tel était le cas, le ou les documents seraient supprimés à la place du dossier sélectionné.

4 Cliquez sur [OK].

Les dossiers sélectionnés sont supprimés.

 Renommer des répertoires et des dossiers utilisateur
Les répertoires et les dossiers utilisateur peuvent être renommés.

 Vous pouvez renommer des dossiers de la boîte publique, laquelle, en revanche, ne peut pas être renommée.
 Ne mettez pas le système hors tension lors du changement du nom d'une boîte ou d'un dossier. Vous risqueriez de 

perdre tous les dossiers et documents présents dans la boîte.

Conseil

 Lorsque le répertoire est protégé par mot de passe, les utilisateurs doivent saisir ce mot de passe pour renommer 
les répertoires ou les dossiers. Les utilisateurs disposant des droits d'administration peuvent renommer tous les 
répertoires et dossiers utilisateur à l'aide de leur mot de passe.

 Les utilisateurs peuvent renommer des zones utilisateur depuis le tableau de bord. 
Pour plus d'informations sur la modification des noms de zone utilisateur depuis le tableau de bord, reportez-vous 
à la section suivante :
 P.30 "Modification des zones utilisateur"

1 Dans le volet Document de l'onglet [Documents], sélectionnez la zone utilisateur que vous 
souhaitez renommer.

2 Si vous sélectionnez une zone utilisateur protégée par mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].
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3 Pour renommer une zone utilisateur, sélectionnez [Fichier (File)] > [Renommer (Rename)]. 
Cochez le dossier que vous souhaitez renommer, puis sélectionnez [Fichier (File)] > [Renommer 
(Rename)].

La fenêtre Renommer le répertoire apparaît.

 Ne sélectionnez pas plusieurs dossiers à la fois. Pour les renommer, sélectionnez-les l'un après l'autre.
 Vous pouvez également renommer un dossier en le sélectionnant dans le volet Document, puis en 

sélectionnant [Renommer (Rename)] dans le menu [Fichier (File)]. Dans ce cas, vérifiez qu'aucun document 
n'est sélectionné dans le volet Contenu. Si tel était le cas, le ou les documents seraient renommés à la place du 
dossier sélectionné.

4 Modifiez le nom, puis cliquez sur [OK].

La boîte de dialogue de confirmation s'affiche.

Les noms des boîtes peuvent être composés de caractères ASCII à l'exception des suivants : 
\ / < > " % & = ' ; : * ? | # [ ] { }.
N'insérez pas d'espace ni de point au début ou à la fin du nom. Le nom d'une boîte peut comporter au maximum 
32 caractères, et celui d'un dossier, 64 caractères.

5 Cliquez sur [OK].

Le répertoire sélectionné est renommé.
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 Affichage et modification des propriétés des répertoires et des dossiers utilisateur
Il est possible d'afficher et de modifier les propriétés des répertoires utilisateur, notamment le mot de passe du 
répertoire, la durée de conservation des documents et les paramètres de notification par e-mail. De même, il est 
possible d'afficher et de vérifier les propriétés des dossiers.
 P.46 "Modification des propriétés des répertoires"
 P.48 "Affichage des propriétés des dossiers"

Conseil

Lorsque le répertoire est protégé par mot de passe, vous devez saisir ce mot de passe pour en modifier les propriétés. 
Les utilisateurs disposant des droits d'administration peuvent modifier toutes les propriétés des répertoires 
utilisateur et celles du répertoire public à l'aide de leur mot de passe.

 Modification des propriétés des répertoires

 Si vous souhaitez modifier les propriétés du répertoire public, vous devez tout d'abord vous connecter en tant 
qu'administrateur système.

 Il est impossible de modifier le mot de passe d'un répertoire auquel un utilisateur est en train d'accéder.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la zone utilisateur pour laquelle 
vous souhaitez afficher et modifier les propriétés.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Sélectionnez [Fichier (File)] > [Propriétés (Properties)].

La fenêtre Propriétés de la boîte apparaît.
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4 Si vous souhaitez modifier les propriétés du répertoire, cliquez sur [Modifier les propriétés 
(Change Properties)].

La fenêtre Modifier les propriétés du répertoire apparaît.

Conseil

Si vous ne voulez pas modifier les propriétés du répertoire, appuyez sur [OK] dans l'écran illustré ci-dessus afin 
de terminer l'opération.

5 Paramétrez les éléments suivants comme il convient, puis appuyez sur [Enregistrer (Save)].

 Modifier le mot de passe de la boîte — Activez cette case à cocher pour modifier le mot de passe de la boîte.

- Ancien mot de passe — Saisissez le mot de passe actuel de la boîte.

- Nouveau mot de passe — Saisissez le nouveau mot de passe de la boîte.

- Confirmer nouveau mdp — Saisissez de nouveau le nouveau mot de passe de la boîte.

 Supprimer le document automatiquement — Activez cette case à cocher si vous souhaitez que les 
documents de cette boîte soient supprimés de façon automatique.

 Durée de conservation des documents — Saisissez le nombre de jours pendant lesquels les documents 
doivent être conservés. Les documents seront supprimés une fois cette période dépassée. Si vous définissez 
une période d'un jour, les documents seront supprimés automatiquement au bout de 24 heures.

 Envoyer un E-mail en cas d'erreur — Cochez cette case pour envoyer en cas d'erreur une notification à 
l'adresse électronique indiquée. Saisissez ensuite l'adresse électronique dans le champ [Adresse e-mail (Email 
Address)].

 Envoyer un E-mail à la fin d'un travail — Cochez cette case pour envoyer une notification à la fin d'un travail 
à l'adresse électronique indiquée. Saisissez ensuite l'adresse électronique dans le champ [Adresse e-mail 
(Email Address)].

 Notification de suppression auto avancée — Activez cette case à cocher pour envoyer automatiquement un 
message de notification à l'adresse électronique indiquée trois jours avant la suppression automatique des 
documents. Saisissez ensuite l'adresse électronique dans le champ [Adresse e-mail (Email Address)].
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- Adresse E-mail — Saisissez l'adresse électronique à laquelle la notification doit être envoyée. Vous ne 
pouvez cocher cette option que lorsque le champ [Supprimer le document automatiquement (Delete 
document automatically)] est sélectionné.

Si un document est automatiquement supprimé par la fonction [Supprimer le document automatiquement 
(Delete document automatically)], l'historique de suppression n'est pas conservé dans le journal. Pour plus 
d'informations sur les journaux, reportez-vous au Guide de TopAccess.

Conseil

Si vous avez oublié l'ancien mot de passe, vous pouvez saisir à la place le mot de passe de l'administrateur dans 
le champ [Ancien mot de passe (Old Password)].
Lorsque les options "Envoyer un E-mail en cas d'erreur" et "Envoyer un E-mail à la fin d'un travail" sont 
sélectionnées, un message de notification est envoyé pour indiquer si les opérations e-Filing suivantes se sont 
correctement déroulées :

 Numériser vers e-Filing
 Copier vers e-Filing
 Imprimer vers e-Filing
 Transmission de fax/fax Internet reçus vers e-Filing
 E-Filing vers impression
 E-Filing vers e-mail

L'administrateur peut paramétrer l'option de notification pour les opérations e-Filing dans TopAccess, sous 
l'onglet [Administration] > Maintenance > page Notification. Pour plus d'informations, reportez-vous au Guide de 
TopAccess.

6 Cliquez sur [OK] pour fermer la fenêtre des propriétés du répertoire.

 Affichage des propriétés des dossiers

Vous pouvez uniquement afficher et vérifier les propriétés des dossiers. Vous ne pouvez pas les modifier.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte contenant le dossier dont 
vous souhaitez afficher les propriétés.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].
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Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Cochez la case du dossier dont vous souhaitez afficher les propriétés et sélectionnez [Fichier 
(File)] > [Propriétés (Properties)].

La fenêtre Propriétés du dossier apparaît. Elle affiche les propriétés du dossier.

 Ne sélectionnez pas plusieurs dossiers à la fois. Vous ne pouvez en effet afficher les propriétés que d'un dossier 
à la fois.

 Vous pouvez également afficher les propriétés d'un dossier en sélectionnant le dossier dans le volet 
Document, puis en cliquant sur [Propriétés (Properties)] dans le menu [Fichier (File)]. Dans ce cas, vérifiez 
qu'aucun document n'est sélectionné dans le volet Contenu. Si un document est sélectionné, ses propriétés 
sont affichées à la place du dossier spécifié.

4 Cliquez sur [OK] pour fermer la fenêtre Propriétés du dossier.

La fenêtre Propriétés du dossier contient les informations suivantes :

 Emplacement — Affiche le répertoire dans lequel se trouve le dossier.

 Contenu — Affiche le nombre de fichiers contenus dans le dossier.

 Créé — Affiche la date et l'heure de création du dossier.

 Modifié(e) — Affiche la date et l'heure de la dernière modification du dossier.
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0.Gestion de documents

L'utilitaire Web e-Filing permet de gérer les documents stockés dans les boîtes e-Filing.
Cette section explique comment effectuer les opérations suivantes :
 P.50 "Affichage des documents"
 P.51 "Renommer des documents"
 P.53 "Suppression de documents"
 P.54 "Impression de documents"
 P.59 "Stockage de documents avec le pilote d'impression"
 P.62 "Archivage de documents"
 P.66 "Envoi d'un message électronique"

 Affichage des documents
Vous pouvez afficher vos fichiers d'images de documents de deux façons. Les options d'affichage des documents sont 
les suivantes :

 Miniature
Le mode Vignettes affiche plusieurs fichiers d'un répertoire ou d'un dossier sélectionné ou encore de plusieurs 
pages d'un document sélectionné. Il s'agit du mode d'affichage défini par défaut. Utilisez-le pour gérer vos 
documents et fichiers.
 P.50 "Utilisation du mode Vignettes"

 Liste
Le mode Liste affiche les propriétés et les noms de fichier sous forme de tableau. Utilisez ce mode pour gérer les 
répertoires et dossiers contenant un grand nombre de fichiers.
 P.51 "Utilisation du mode Liste"

 Utilisation du mode Vignettes

Si vous n'en avez pas choisi un autre, le mode Vignettes est défini par défaut. Il affiche sous forme de vignette chaque 
fichier ou dossier que vous avez sélectionné dans le volet de gauche, ou encore chaque page d'un document avec le 
nom du fichier ou le numéro de la page, ainsi qu'une case à cocher. Activez les cases des pages ou fichiers à déplacer, 
copier, supprimer ou imprimer.
Pour retourner à l'affichage des vignettes, cliquez sur [Affichage (View)] > [Vignettes (Thumbnail)].
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 Utilisation du mode Liste

Ce mode affiche, sous forme de liste, les noms des fichiers, dossiers ou répertoires ainsi que leurs propriétés et les 
cases à cocher correspondantes. Il se peut que vous trouviez ce mode plus pratique que le mode Vignettes pour gérer 
les répertoires et dossiers contenant un grand nombre de fichiers. Activez les cases des fichiers à déplacer, copier, 
supprimer ou imprimer.
Pour afficher les fichiers en mode Liste, cliquez sur [Affichage (View)] > [Liste (List)].

 Renommer des documents
Les documents peuvent être renommés.

Lorsque vous modifiez le nom d'un document, ne mettez pas le système hors tension tant que le nouveau nom n'est 
pas sauvegardé ; vous risqueriez de perdre votre document.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document que vous souhaitez renommer.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].
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3 Cochez le document à renommer et sélectionnez [Fichier (File)] > [Renommer (Rename)].

La fenêtre Renommer Document apparaît.

Conseil

Les utilisateurs peuvent également renommer un document en le sélectionnant dans le volet Document, puis 
[Fichier (File)] > [Renommer (Rename)].

4 Saisissez le nom du document et cliquez sur [OK].

La boîte de dialogue de confirmation s'affiche.

Les noms des documents sont composés de caractères ASCII à l'exception des suivants : 
\ / < > " % & = ' ; : * ? | # [ ] { }. 
N'insérez pas d'espace ni de point au début ou à la fin du nom. Un nom de document peut comporter au 
maximum 64 caractères.

5 Cliquez sur [OK].

Le document est renommé.
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 Suppression de documents
Il est possible de supprimer des documents d'un répertoire ou d'un dossier.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant les 
documents que vous souhaitez supprimer.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Cochez les documents que vous souhaitez supprimer, puis sélectionnez [Modifier (Edit)] > 
[Supprimer (Delete)].

La boîte de dialogue de confirmation s'affiche.

Les utilisateurs peuvent également supprimer un document en le sélectionnant à partir du volet Documents, 
puis [Modifier (Edit)] > [Supprimer (Delete)]. Dans ce cas, vérifiez qu'aucune page n'est sélectionnée dans le volet 
Contenu. Si tel était le cas, un message d'alerte vous indiquerait que la suppression de pages est impossible en 
mode d'affichage.

4 Cliquez sur [OK].

Les documents sont supprimés.
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 Impression de documents
Vous pouvez imprimer des documents et des images à partir des répertoires et dossiers de l'utilitaire Web e-Filing. 
Pour cela, vous disposez des deux méthodes suivantes :
 P.54 "Impression de l'intégralité d'un document"
 P.57 "Test d'impression"

 Impression de l'intégralité d'un document

Vous pouvez imprimer l'intégralité d'un document en sélectionnant diverses options d'impression.

1 Dans le volet Document, sélectionnez la boîte ou le dossier contenant le document que vous 
souhaitez imprimer.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Cochez la case du document à imprimer et sélectionnez [Fichier (File)] > [Imprimer le document 
(Print Document)].

La fenêtre Imprimer apparaît.

Vous pouvez également imprimer un document en le sélectionnant dans le volet Document et en cliquant sur 
[Fichier (File)] > [Imprimer le document (Print Document)]. Toutefois, vous ne pouvez pas imprimer de pages 
individuelles même en activant leurs cases à cocher dans le volet Contenu.



3.UTILISATION SUR UN ORDINATEUR CLIENT

Gestion de documents    55

U
T

ILIS
A

T
IO

N
 S

U
R

 U
N

 O
R

D
IN

A
T

EU
R

 C
LIEN

T

4 Paramétrez les options ci-dessous comme il convient et cliquez sur [Imprimer (Print)].

 Recto verso — Cette option permet d'imprimer le document sur les deux faces du papier. Vous pouvez choisir 
entre Livret ou Bloc-notes.

 Nombre de copies — Saisissez le nombre de copies à imprimer.

 Copies triées — Sélectionnez cette option pour séparer les exemplaires du document imprimé.

 Copies groupées — Sélectionnez cette option pour séparer chaque page du document imprimé.

 Copies tri en alternance — Sélectionnez cette option pour que chaque copie du document sorte dans une 
orientation différente.

 Type de papier — Sélectionnez le type de papier souhaité.

 Mode toner — Sélectionnez cette option pour spécifier le toner à utiliser pour l'impression. Cette option n'est 
disponible qu'avec la série e-STUDIO5008LP.

 Code départemental — Saisissez un code départemental de 1 à 63 chiffres, si nécessaire. La saisie d'un code 
départemental est requise avant l'impression d'un document si la fonction de gestion par codes 
départementaux est activée sur le système.

 Code projet : Saisissez un code projet de 1 à 63 chiffres, si nécessaire. Si la fonction code projet est activée sur 
le système, vous devez entrer ce code pour imprimer un document.

 Source papier — Sélectionnez la source pour l'alimentation papier. Sélectionnez une source de papier 
correspondant au format de l'impression.

 Destination — Sélectionnez le bac de sortie du document.

 Agrafer — Indiquez si le document doit être agrafé. Le cas échéant, indiquez de quelle façon.

 Reliure — Sélectionnez cette option pour que le document soit plié ou agrafé au centre à sa sortie. Vous 
pouvez définir le mode de reliure du document à sa sortie.

- Pliage central : le document est plié au centre.

- Agrafage à cheval : le document est agrafé en deux points et plié au centre.

 Perforation — Cette option permet de perforer le document. Le cas échéant, indiquez de quelle façon.



3.UTILISATION SUR UN ORDINATEUR CLIENT

56    Gestion de documents

 Numéro de page : cette option permet d'imprimer les numéros de page.

- Position : cette option permet d'imprimer les numéros de page. Le cas échéant, indiquez à quel endroit.

- Première page : saisissez le numéro qui doit apparaître sur la première page du document. Lorsque 
l'option "Insertion intercal./couverture - Ajouter couv. avant" est sélectionnée, la couverture correspond à 
la première page et la première page du document à la deuxième page.

 Date/Heure : cette option permet d'imprimer la date et l'heure sur chacune des pages.

- Position : sélectionnez cette option pour imprimer la date et l'heure sur chaque page. Le cas échéant, 
indiquez l'endroit où ces données devront apparaître.

 Décalage d'image : cette option permet de décaler les images imprimées.

- Position : sélectionnez cette option si vous souhaitez décaler les images imprimées.

- Décalage marge - Avant — Sélectionnez la largeur de la marge qui doit être ajoutée pour décaler l'image 
du document vers l'avant.

- Décalage marge - Arrière — Sélectionnez la largeur de la marge qui doit être ajoutée pour décaler l'image 
du document vers l'arrière.

 Insertion intercal./couverture : sélectionnez cette option si vous souhaitez imprimer la première ou la 
quatrième de couverture.

- Ajouter couv. avant : cette option d'impression d'une couverture avant permet d'insérer ou d'imprimer 
une couverture sur une feuille provenant d'un autre bac que celui défini par l'option Source papier. Pour 
activer l'impression d'une couverture avant, cochez cette case et sélectionnez la source d'alimentation de 
la feuille de couverture ainsi que le style d'impression à utiliser.

- Ajouter couv. arr. : cette option d'impression permet d'insérer ou d'imprimer une quatrième de 
couverture sur une feuille provenant d'un autre bac que celui défini par l'option Source papier. Pour activer 
l'impression d'une quatrième de couverture, cochez cette case et sélectionnez la source d'alimentation de 
la feuille de couverture, ainsi que le style d'impression à utiliser.

- Intercalaires : cette option d'impression permet d'insérer une feuille entre deux pages ou d'imprimer une 
page spécifique sur une feuille provenant d'un bac autre que celui défini par l'option Source papier. Cette 
option est utile pour insérer une feuille vierge entre deux chapitres ou pour imprimer les pages de titre de 
chapitre sur du papier différent. Pour activer l'impression d'intercalaires, cochez cette case et sélectionnez 
la source d'alimentation, ainsi que le style d'impression à utiliser. Saisissez ensuite, dans le champ [Pages], 
les numéros des pages auxquelles des feuilles sont à insérer et séparez-les par des virgules si plusieurs 
pages sont spécifiées.

- Interfoliage : cette option permet de définir la fonction d'interfoliage qui est utile si vous souhaitez insérer 
du papier dont le type ou la source est différente entre chaque page de votre travail d'impression. Vous 
pouvez par exemple utiliser cette option pour insérer des feuilles vierges de couleur entre des transparents. 
Pour activer l'option d'interfoliage, cochez cette case et spécifiez la source d'alimentation. Activez 
également la case à cocher [Dupliquer (Duplicate)] si vous souhaitez imprimer les images des pages 
précédentes sur les feuilles insérées.

- Type de papier (Insert) — Lorsque vous sélectionnez le mode d'alimentation manuelle (bypass) dans la 
liste déroulante Source de l'option "Ajouter couv. avant", "Ajouter couv. arr.", "Intercalaires" ou 
"Interfoliage", sélectionnez ici le type de papier à insérer depuis le bypass.

 Impression programmée — Activez cette case à cocher pour imprimer un travail à une date et une heure 
ultérieures. Lorsque cette option est sélectionnée, définissez la date et l'heure auxquelles le travail doit être 
imprimé dans le champ [Date et heure (Date & Time)].

 La plage du nombre de copies que vous pouvez sélectionner change en fonction du modèle.
 L'option [Copies tri en alternance (Rotate Sort Copies)] est activée uniquement lorsque vous saisissez un 

chiffre supérieur à 1 dans le champ [Nombre de copies (Number of Copies)]. Pour réaliser des copies avec tri en 
alternance, du papier au format Portrait et Paysage doit être placé dans deux cassettes distinctes. Le bac de 
sortie interne est quant à lui automatiquement défini comme destination si vous sélectionnez cette option.

 Les fonctions "Agrafage", "Reliure" et "Perforation" sont uniquement activées lorsqu'une unité (facultative) 
correspondante est installée. Pour plus d'informations sur le style de finition et les options requises, reportez-
vous au Guide des caractéristiques.

 Les options "Agrafage" et "Insertion intercal./couverture - Interfoliage" ne peuvent pas être activées en même 
temps. L'activation de l'une de ces options entraîne la désactivation automatique de l'autre.
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Conseil

 Cliquez sur [Imprimer (Print)] pour imprimer le document et afficher la fenêtre de résultat de l'impression.
 Cliquez sur [Annuler (Cancel)] pour fermer la fenêtre d'impression sans imprimer.
 Cliquez sur [Réinitialiser (Reset)] pour restaurer les paramètres par défaut des propriétés d'impression.
 Lorsque l'option [Insertion intercal./couverture - Ajouter couv. avant (Cover/Sheet Insertion - Use Front 

Cover)] est sélectionnée, la première de couverture est considérée comme la page 1 et les numéros des pages 
imprimées commencent à 2.

 Lorsque les paramètres de gestion des utilisateurs et ceux de gestion par codes départementaux sont activés, 
les quotas autorisés pour le département et l'utilisateur s'affichent dans la zone supérieure droite de la page.

5 Cliquez sur [Fermer (Close)] pour revenir à la page de l'onglet [Documents].

Conseil

Lorsque vous souhaitez annuler un travail avant la fin de l'impression, accédez à TopAccess, cliquez sur l'onglet 
[Etat trav. (Job Status)] > [Imprimer (Print)], sélectionnez le travail, puis appuyez sur [Supprimer (Delete)].

 Test d'impression

Cette fonction permet tout simplement d'imprimer une copie d'un document selon les paramètres d'impression 
définis.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document que vous souhaitez imprimer.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].
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3 Cochez la case du document à imprimer et sélectionnez [Fichier (File)] > [Test d'impr. (Test 
Print)].

La fenêtre Test d'impression apparaît.

Vous pouvez également effectuer un test d'impression en sélectionnant un document dans le volet Document, 
puis en cliquant sur [Fichier (File)] > [Test d'impr. (Test Print)]. Toutefois, vous ne pouvez pas imprimer de pages 
individuelles même en activant leurs cases à cocher dans le volet Contenu.

4 Indiquez si vous souhaitez imprimer toutes les pages du document ou uniquement les pages 
spécifiées, puis cliquez sur [Imprimer (Print)].

 Toutes les pages — Sélectionnez cette option pour imprimer toutes les pages du document.

 [premier numéro de page] - [dernier numéro de page] Pages — Sélectionnez cette option pour indiquer les 
pages à imprimer. Lorsque cette option est sélectionnée, saisissez le numéro de la première et de la dernière 
page à imprimer dans leurs champs respectifs.

 Code départemental — Saisissez le code départemental. Vous devez saisir ce code uniquement si la fonction 
de gestion par codes départementaux est activée sur le système.

 Code projet : saisissez un code projet. Il ne doit être saisi que si la fonction code projet est activée sur le 
système.

 Mode toner — Sélectionnez cette option pour spécifier le toner à utiliser pour l'impression. Cette option n'est 
disponible qu'avec la série e-STUDIO5008LP.

Conseil

 Lorsque les paramètres de gestion des utilisateurs et ceux de gestion par département sont activés, les quotas 
autorisés pour le département et l'utilisateur s'affichent dans la zone supérieure droite de la page.

 Cliquez sur [Imprimer (Print)] pour imprimer une copie du document et afficher la fenêtre de résultat de 
l'impression.

 Cliquez sur [Annuler (Cancel)] pour fermer la fenêtre d'impression de test sans imprimer.

5 Cliquez sur [Fermer (Close)] pour revenir à la page de l'onglet [Documents].

Lorsque vous souhaitez annuler un travail avant la fin de l'impression, accédez à TopAccess, cliquez sur l'onglet 
[Etat trav. (Job Status)] > [Imprimer (Print)], sélectionnez le travail, puis appuyez sur [Supprimer (Delete)].
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 Stockage de documents avec le pilote d'impression
A partir d'une application s'exécutant sous le système d'exploitation Windows, vous pouvez envoyer un document 
sous forme de travail d'impression vers e-Filing avec le pilote de l'imprimante.
Vous pouvez stocker vos documents dans le répertoire public ou dans un répertoire utilisateur.
 P.59 "Enregistrement d'un travail d'impression dans le répertoire public"
 P.60 "Enregistrement d'un travail d'impression dans un répertoire utilisateur"

Lorsque vous utilisez le pilote d'impression pour stocker un document dans e-Filing, c'est l'image d'impression (et 
non le document original enregistré sur votre ordinateur) qui y sera stockée.

Conseil

 Pour plus d'informations sur le pilote d'impression, reportez-vous au Guide de l'impression.
 Pour plus d'informations sur le répertoire public et le répertoire utilisateur, reportez-vous à la section suivante :
 P.8 "Fonctionnalités e-Filing"

 Vous pouvez également stocker un document numérisé dans l'e-Filing en utilisant l'écran tactile. Pour plus 
d'informations, reportez-vous à la section suivante :
 P.19 "Stockage de documents"

 Enregistrement d'un travail d'impression dans le répertoire public

1 Ouvrez le document que vous souhaitez stocker dans le répertoire.

2 Dans l'application, cliquez sur [Fichier (File)] > [Imprimer (Print)].
La boîte de dialogue [Imprimer (Print)] apparaît.

3 Sélectionnez le pilote d'impression du système à utiliser et cliquez sur [Préférences 
(Preferences)].
La boîte de dialogue [Options d'impression (Printing Preferences)] apparaît.

Conseil

La procédure d'affichage de la boîte de dialogue [Options d'impression (Printing Preferences)] pour le pilote 
d'impression peut varier en fonction de l'application que vous utilisez. Reportez-vous à la documentation de 
votre application sur l'affichage de la boîte de dialogue [Options d'impression (Printing Preferences)].

4 Sélectionnez le type de travail d'impression dans l'onglet [Basique].
Sélectionnez [Stocker vers e-Filing] dans la liste déroulante [Travail d'impression].
Si nécessaire, sélectionnez d'autres options d'impression.

Conseil

 Un travail d'impression est enregistré à l'aide de l'option d'impression définie.
 Pour les séries e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC, e-STUDIO8508A

Les options d'impression autres que [Nombre de copies (Number of Copies)] sont définies dans un travail et 
enregistrées dans la boîte publique.

 Pour la série e-STUDIO5008LP
Les options d'impression autres que [Nombre de copies (Number of Copies)] et [Mode toner (Toner Mode)] 
sont définies dans un travail et enregistrées dans la boîte publique.
Si vous essayez d'imprimer un travail dans la boîte publique, même si le paramètre [Mode toner (Toner Mode)] 
dans l'onglet [Principal (Basic)] est modifié, l'opération ne sera pas reflétée sur l'impression.
L'impression sera effectuée avec le paramètre suivant du [Mode toner (Toner Mode)].

- Le paramètre par défaut du [Mode toner (Toner Mode)] est défini dans TopAccess.
- Le paramètre est défini dans [Paramètres (Settings)] dans le répertoire e-Filing spécifié sur l'écran tactile du 

système.
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Appuyez sur [...] en regard de la boîte [Travail d'impression (Print Job)]. La boîte de dialogue [Stock. vers e-Filing 
(Store to e-Filing)] s'affiche.

5 Sélectionnez [Boîte publique (Public Box)] pour enregistrer le travail·d'impression et cliquez sur 
[OK].

Conseil

 Si vous voulez enregistrer un travail d'impression dans un dossier spécifique, indiquez le nom du dossier dans 
le champ [Dossier (Box Folder)].
Pour enregistrer les données dans un dossier existant, indiquez le nom du dossier dans le champ [Dossier (Box 
Folder)].
Pour enregistrer les données dans un nouveau dossier, indiquez le nom de ce dernier dans le champ [Dossier 
(Box Folder)].

 Si vous voulez imprimer un travail tout en l'enregistrant dans la boîte publique, activez la case à cocher 
[Imprimer (Print)].
Un travail sera imprimé avec le paramètre [Couleur (Color)] ou [Mode toner (Toner Mode)] dans l'onglet 
[Principal (Basic)].

6 Cliquez sur [OK] ou sur [Imprimer (Print)] pour enregistrer le travail d'impression.
Le travail d'impression est enregistré dans le répertoire public spécifié.

 Enregistrement d'un travail d'impression dans un répertoire utilisateur

1 Ouvrez le document que vous souhaitez stocker dans le répertoire.

2 Dans l'application, cliquez sur [Fichier (File)] > [Imprimer (Print)].
La boîte de dialogue [Imprimer (Print)] apparaît.

3 Sélectionnez le pilote d'impression du système à utiliser et cliquez sur [Préférences 
(Preferences)].
La boîte de dialogue [Options d'impression (Printing Preferences)] apparaît.

Conseil

La procédure d'affichage de la boîte de dialogue [Options d'impression (Printing Preferences)] pour le pilote 
d'impression peut varier en fonction de l'application que vous utilisez. Reportez-vous à la documentation de 
votre application sur l'affichage de la boîte de dialogue [Options d'impression (Printing Preferences)].



3.UTILISATION SUR UN ORDINATEUR CLIENT

Gestion de documents    61

U
T

ILIS
A

T
IO

N
 S

U
R

 U
N

 O
R

D
IN

A
T

EU
R

 C
LIEN

T

4 Sélectionnez le type de travail d'impression dans l'onglet [Basique].
Sélectionnez [Stocker vers e-Filing] dans la liste déroulante [Travail d'impression].
Si nécessaire, sélectionnez d'autres options d'impression.

Conseil

 Un travail d'impression est enregistré à l'aide de l'option d'impression définie.
 Pour les séries e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC, e-STUDIO8508A

Les options d'impression autres que [Nombre de copies (Number of Copies)] sont définies dans un travail et 
enregistrées dans la boîte utilisateur.

 Pour la série e-STUDIO5008LP
Les options d'impression autres que [Nombre de copies (Number of Copies)] et [Mode toner (Toner Mode)] 
sont définies dans un travail et enregistrées dans la boîte utilisateur.
Si vous essayez d'imprimer un travail dans la boîte utilisateur, même si le paramètre [Mode toner (Toner 
Mode)] dans l'onglet [Principal (Basic)] est modifié, l'opération ne sera pas reflétée sur l'impression.
L'impression sera effectuée avec le paramètre suivant du [Mode toner (Toner Mode)].

- Le paramètre par défaut du [Mode toner (Toner Mode)] est défini dans TopAccess.
- Le paramètre est défini dans [Paramètres (Settings)] dans le répertoire e-Filing spécifié sur l'écran tactile du 

système.

Appuyez sur [...] en regard de la boîte [Travail d'impression (Print Job)]. La boîte de dialogue [Stock. vers e-Filing 
(Store to e-Filing)] s'affiche.

5 Sélectionnez le répertoire utilisateur dans lequel vous voulez enregistrer le travail d'impression.
 Sélectionnez le numéro de répertoire utilisateur désiré dans la liste [Stocker dans (Stock to)].

 Saisissez le mot de passe du répertoire utilisateur dans le champ [Mdp (Password)].

 Si vous voulez imprimer un travail tout en l'enregistrant dans le répertoire utilisateur, activez la case à cocher 
[Imprimer (Print)].
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Conseil

 Si vous voulez enregistrer un travail d'impression dans un dossier spécifique, indiquez le nom du dossier dans 
le champ [Dossier (Box Folder)].
Pour enregistrer les données dans un dossier existant, indiquez le nom du dossier dans le champ [Dossier (Box 
Folder)].
Pour enregistrer les données dans un nouveau dossier, indiquez le nom de ce dernier dans le champ [Dossier 
(Box Folder)].

 Si vous voulez imprimer un travail tout en l'enregistrant dans la boîte publique, activez la case à cocher 
[Imprimer (Print)]. Un travail sera imprimé avec le paramètre [Couleur (Color)] ou [Mode toner (Toner Mode)] 
dans l'onglet [Principal (Basic)].

Si la case à cocher "Activer la communication SNMP" de l'onglet [Configuration] est activée, seules les zones 
utilisateur qui ont été paramétrées seront affichées dans la liste déroulante.

6 Cliquez sur [OK] ou sur [Imprimer (Print)] pour enregistrer le travail d'impression.
Le travail d'impression est enregistré dans le répertoire utilisateur spécifié.

 Archivage de documents
L'utilitaire Web e-Filing permet d'archiver les documents stockés dans le répertoire e-Filing et de charger le fichier 
archivé sur votre ordinateur. Ces fichiers peuvent également être chargés depuis votre ordinateur vers le système 
e-Filing de ce système ou de tout autre système de la même gamme e-STUDIO.
 P.62 "Chargement d'un document archivé"
 P.64 "Chargement des documents archivés"

Conseil

Les fichiers archivés sont compatibles avec la même série que le système multifonction TOSHIBA, mais pas avec une 
autre série.

 Chargement d'un document archivé

Vous pouvez archiver les documents dans la boîte et les charger sur votre ordinateur. Utilisez cette fonction pour 
créer un fichier de sauvegarde de vos documents dans e-Filing.
La procédure ci-dessous décrit la procédure de chargement d'un document archivé à l'aide de Microsoft Internet 
Explorer.

 Le fichier archivé contient tous les documents que vous avez spécifiés pour l'archivage, lesquels ne peuvent pas 
être ouverts sur votre ordinateur

 Vous pouvez créer un fichier archivé contenant les documents d'un même dossier ou d'un même répertoire.
 Vous pouvez créer un fichier archivé contenant plus de 2 Go de données.
 Ne fermez pas la fenêtre principale ni la fenêtre enfant en cliquant sur le bouton [X]. Cette opération rendrait en 

effet impossible le chargement des documents archivés. Si vous fermez la fenêtre en cliquant sur [X] par erreur, 
mettez le système hors tension avant de le remettre sous tension.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document que vous souhaitez archiver.
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2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Cochez la case du document à archiver et sélectionnez [Fichier (File)] > [Archiver document 
(Archive Document)].

La boîte de dialogue de confirmation apparaît.

Les utilisateurs peuvent également archiver un document en le sélectionnant dans le volet Document, puis 
[Fichier (File)] > [Archiver document (Archive Document)]. Toutefois, vous ne pouvez pas archiver de pages 
individuelles même en activant leurs cases à cocher dans le volet Contenu.

4 Cliquez sur [OK] pour lancer le processus d'archivage.

5 La fenêtre Archiver document apparaît. Pendant l'archivage, vous pouvez quitter le processus en 
cliquant sur [Annuler (Cancel)].

Lorsque l'archivage du document est terminé, le message "Le document a été archivé" apparaît.

Si l'utilitaire Web e-Filing est en train d'effectuer une tâche, attendez qu'il ait fini.
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6 Cliquez sur le lien du nom du fichier pour télécharger le fichier archivé.

Les fichiers sont enregistrés dans un dossier défini par votre navigateur.

7 Cliquez sur [Fermer (Close)].

 Chargement des documents archivés

Si vous avez téléchargé sur votre ordinateur depuis le système un fichier archivé, vous pouvez le charger dans un 
répertoire e-Filing. Lorsque vous chargez le fichier archivé, celui-ci est automatiquement extrait et les documents 
sont créés dans le répertoire spécifié.

 Si un document du même nom existe déjà dans le répertoire, le document extrait sera renommé avec 3 chiffres 
ajoutés au nom d'origine.

 Ne fermez pas la fenêtre principale ni la fenêtre enfant en cliquant sur le bouton [X]. Cette opération rendrait en 
effet impossible le téléchargement des documents archivés. Si vous fermez la fenêtre en cliquant sur [X] par erreur, 
mettez le système hors tension avant de le remettre sous tension.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier dans lequel 
vous souhaitez charger les documents archivés.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].
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3 Sélectionnez [Fichier (File) > [Charger un document archivé (Upload Archived Document)].

La fenêtre Charger un document archivé apparaît.

4 Cliquez sur [Parcourir (Browse)].

La boîte de dialogue [Choisir le fichier à charger (Choose File to Upload)] apparaît.

5 Sélectionnez un fichier archivé à télécharger et cliquez sur [Ouvrir (Open)].

Vous retournez alors à la fenêtre de chargement du document archivé et le chemin du dossier du fichier 
sélectionné apparaît dans la case "Fichier archivé".

6 Cliquez sur [OK].

La boîte de dialogue de confirmation apparaît.

7 Cliquez sur [OK] pour lancer le chargement du fichier archivé.
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Si vous sélectionnez un fichier archivé non pris en charge dans votre modèle ou un fichier non archivé, un 
message d'erreur s'affiche. Dans ce cas, sélectionnez le bon fichier archivé et réessayez.

8 La fenêtre Charger un document archivé montre le processus de chargement. Vous pouvez 
quitter à tout moment le processus de chargement en cliquant sur [Annuler (Close)].

Lorsque le chargement du document est terminé, un message vous informe que le document a été chargé.

Si l'utilitaire Web e-Filing est en train d'effectuer une tâche, attendez qu'il ait fini.

9 Cliquez sur [Fermer (Close)].

Les documents sont ajoutés dans le répertoire sélectionné.

 Envoi d'un message électronique
Vous pouvez envoyer par messagerie électronique des documents depuis l'utilitaire Web e-Filing.
Lorsque vous exécutez cette fonction, le système crée un message électronique à l'aide des documents sélectionnés 
sous forme de fichier joint et il envoie le message électronique directement à partir du système.

 Pour que la commande Envoyer un E-mail soit disponible, l'administrateur réseau doit correctement définir les 
paramètres de messagerie du système.

 Lorsque vous utilisez un système numérique couleur multifonctions (couleur MFP), vous pouvez envoyer des 
documents e-Filing sous forme de messages électroniques uniquement s'ils ont été enregistrés en respectant les 
conditions ci-dessous. Vérifiez les propriétés des documents avant de les envoyer.

- Le document a été enregistré à l'aide de la fonction de copie du système et en noir et blanc.
- Le document a été enregistré à l'aide de la fonction de numérisation du système.
- Le document a été enregistré à l'aide de la fonction de transfert de fax/fax Internet reçus.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document que vous souhaitez envoyer par e-mail.

Pour utiliser cette fonctionnalité, la fonction de numérisation est requise.
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2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Cochez la case du document à envoyer par e-mail et sélectionnez [Fichier (File) > [Envoyer un 
e-mail (Send Email)].

La page Envoyer un E-mail apparaît.

Conseil

 Les utilisateurs peuvent également envoyer un document par e-mail en le sélectionnant dans le volet 
Document, puis [Fichier (File)] > [Archiver document (Archive Document)].

 Les utilisateurs peuvent également envoyer jusqu'à 100 pages ou documents en activant les cases à cocher 
appropriées dans le volet Contenu.
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4 Paramétrez les éléments suivants comme il convient, puis cliquez sur [Envoyer (Send)].

[Paramétrage de la destination A : (TO: Destination Setting)] — Cliquez sur ce bouton pour indiquer la 
destination. La liste des destinataires apparaît. Pour plus d'informations sur la spécification de la destination, 
reportez-vous à la section suivante :
 P.70 "Paramétrage de la destination"
[Paramétrage de la destination CC : (CC: Destination Setting)] — Cliquez sur ce bouton pour indiquer la 
destination CC.
[Paramétrage de la destination BCC : (BCC: Destination Setting)] — Cliquez sur ce bouton pour indiquer la 
destination BCC.
Objet — Ce champ définit l'objet des documents du message électronique. Sélectionnez l'option [Envoyer les 
données depuis (nom du périphérique) (infos de liste.) (Send data from (Device name) (Box Info.)] définie par 
défaut ou saisissez l'objet souhaité dans la liste. Pour ajouter la date et l'heure à l'objet du message, activez la 
case à cocher [Ajouter la date et l'heure à l'objet (Add the date and time to the subject)].
De — Saisissez l'adresse électronique de l'expéditeur. Lorsque le destinataire répond, son message est envoyé à 
cette adresse électronique.
Depuis le nom — Saisissez le nom de l'expéditeur du message électronique.
Corps — Saisissez le corps du message en veillant à ne pas dépasser 1000 caractères (espaces inclus).
Format de fichier — Sélectionnez le format de fichier dans lequel sera converti le document reçu.

 TIFF (Multi) — Sélectionnez cette option pour enregistrer les images numérisées au format TIFF multipage.

 TIFF (Simple) — Sélectionnez cette option pour enregistrer les images numérisées séparément au format TIFF 
simple.

 PDF (Multi) — Sélectionnez cette option pour enregistrer les images numérisées au format PDF multipage.

 PDF (Simple) — Sélectionnez cette option pour enregistrer les images numérisées séparément au format PDF 
simple.

 XPS (Multi)  — Sélectionnez cette option pour enregistrer les images numérisées au format XPS multipage.

 XPS (Simple) — Sélectionnez cette option pour enregistrer les images numérisées séparément au format XPS 
simple.

 JPEG — Sélectionnez cette option pour enregistrer les images numérisées au format JPEG. Cette option est 
disponible uniquement si les images ont été numérisées en mode [Couleurs (Full Color)] ou [Niv.gris (Gray 
Scale)].

Cryptage : activez cette option pour crypter les fichiers PDF si vous avez sélectionné le format de fichier "PDF 
(Multi)" ou "PDF (Simple)".
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 Cryptage — Activez cette case à cocher pour crypter les fichiers PDF.

 Mot de passe utilisateur — Saisissez le mot de passe requis pour ouvrir le fichier PDF crypté.

 Mot de passe master — Saisissez le mot de passe requis pour modifier le paramètre de cryptage PDF.

 Niveau de cryptage — Sélectionnez le niveau de cryptage souhaité.

- RC4 à 40 bits — Sélectionnez cette option pour appliquer un niveau de cryptage compatible avec Acrobat 
3.0, PDF V1.1.

- RC4 à 128 bits — Sélectionnez cette option pour appliquer un niveau de cryptage compatible avec Acrobat 
5.0, PDF V1.4.

- AES à 128 bits — Sélectionnez cette option pour appliquer un niveau de cryptage compatible avec Acrobat 
7.0, PDF V1.6.

 Droit — Sélectionnez le type de droit désiré sur les fichiers PDF cryptés.

- Impression

- Modification des documents

- Copie ou extraction de contenu

- Extraction de contenu pour accessibilité

Nom du fichier : spécifiez le type de dénomination du fichier joint.
Fragmenter le message — Sélectionnez la taille de fragmentation des messages.
Code départemental — Saisissez le code départemental, si nécessaire.
Code projet : saisissez un code projet, si besoin.

 Si la fonction de cryptage forcé est activée, seules les options [PDF (Multi)] et [PDF (Simple) (PDF (Single)] sont 
disponibles. Pour plus d'informations sur la fonction de cryptage forcé, reportez-vous au Guide 
d'administration.

 Les fichiers enregistrés au format XPS peuvent être utilisés sous Vista ou version ultérieure et 
Windows Server 2008 ou version ultérieure à condition que .NET Framework 3.0 soit installé.

 Seuls les utilisateurs autorisés peuvent modifier ces mots de passe. Les utilisateurs ne peuvent pas modifier 
les paramètres des champs [Niveau de cryptage (Encryption Level)] et [Droit (Authority)] ci-dessous s'ils ne 
sont pas autorisés à modifier le mot de passe master. Pour redéfinir ces mots de passe, contactez votre 
administrateur. Pour plus d'informations sur la fonction de cryptage, reportez-vous au Guide 
d'administration.

Conseil

 Si la fonction de cryptage forcé est activée, vous ne pouvez pas désactiver la case à cocher [Cryptage 
(Encryption)]. Pour plus d'informations sur la fonction de cryptage forcé, reportez-vous au Guide 
d'administration.

 Les mots de passe utilisateur et master ne sont pas définis en usine. Si le mot de passe master doit être défini, 
consultez votre administrateur réseau.

 Pour les mots de passe, vous devez saisir des caractères alphanumériques codés sur un octet en veillant à ne 
pas dépasser la limite autorisée, soit 32 caractères.

 Les mots de passe utilisateur et master doivent être différents.

5 Cliquez sur [Fermer (Close)].
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 Paramétrage de la destination

La page Liste des destinataires permet de définir les destinations vers lesquelles les documents e-Filing seront 
envoyés par e-mail.
Pour définir les destinataires, vous pouvez saisir leur adresse électronique, les sélectionner dans le carnet d'adresses, 
sélectionner des groupes de destinataires dans le carnet d'adresses ou les rechercher sur le serveur LDAP.

Conseil

La page Liste des destinataires permet de définir jusqu'à 400 destinations.

Si vous avez sélectionné l'option [Authentification LDAP (LDAP Authentication)] pour [Type d'authentification 
(Authentication Type)], vous pouvez choisir uniquement des destinations enregistrées sur les serveurs LDAP 
authentifiés. Pour plus d'informations sur l'option Authentification LDAP, reportez-vous au Guide de TopAccess.

 P.70 "Saisie des destinataires"
 P.71 "Sélection des destinataires dans le répertoire téléphonique"
 P.72 "Sélection de groupes depuis un répertoire téléphonique"
 P.73 "Recherche de destinataires sur le serveur LDAP"
 P.74 "Suppression des contacts de la liste des destinataires"

Saisie des destinataires

Suivez les étapes décrites ci-après pour ajouter manuellement un destinataire à la liste des destinataires.

1 Cliquez sur [Configurer la destination (Destination Setting)] pour accéder à la page Liste des 
destinataires.

2 Cliquez sur [Nouvelle (New)].

La page Propriétés du contact apparaît.

3 Saisissez l'adresse e-mail du destinataire, puis appuyez sur [OK].

Le nouveau destinataire est ajouté à la liste des destinataires.

4 Répétez les étapes 2 et 3 pour ajouter autant de destinataires que nécessaire.

Conseil

Vous pouvez supprimer les contacts ajoutés à la liste des destinataires avant d'enregistrer les paramètres de 
destination.
 P.74 "Suppression des contacts de la liste des destinataires"

5 Cliquez sur [Enregistrer (Save)].

Les contacts sont ajoutés comme destinations.
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Sélection des destinataires dans le répertoire téléphonique

Suivez la procédure ci-dessous pour sélectionner les destinataires dans le répertoire téléphonique.

1 Cliquez sur [Configurer la destination (Destination Setting)] pour accéder à la page Liste des 
destinataires.

2 Cliquez sur [Carnet d'adresses (Address Book)].

La page Répertoire téléphonique apparaît.

3 Dans la colonne E-mail, activez les cases à cocher des utilisateurs que vous voulez ajouter et 
cliquez sur [Ajouter (Add)].

Les destinataires sélectionnés sont ajoutés à la page Liste des destinataires.

Conseil

 Si vous voulez trier les destinataires dans des groupes spécifiques, sélectionnez le nom du groupe souhaité 
dans la case [Groupe (Group)].

 Vous pouvez supprimer les contacts ajoutés à la liste des destinataires avant d'enregistrer les paramètres de 
destination.
 P.74 "Suppression des contacts de la liste des destinataires"

4 Cliquez sur [Enregistrer (Save)].

Les contacts sont ajoutés comme destinations.
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Sélection de groupes depuis un répertoire téléphonique

Suivez la procédure ci-dessous pour sélectionner les groupes dans le répertoire téléphonique.

1 Cliquez sur [Configurer la destination (Destination Setting)] pour accéder à la page Liste des 
destinataires.

2 Cliquez sur [Adresse du groupe (Address Group)].

La page Adresse du groupe apparaît.

3 Activez les cases à cocher des groupes contenant les destinataires souhaités et cliquez sur 
[Ajouter (Add)].

Tous les destinataires des groupes sélectionnés sont ajoutés dans la page Liste des destinataires.

Conseil

Vous pouvez supprimer les contacts ajoutés à la liste des destinataires avant d'enregistrer les paramètres de 
destination.
 P.74 "Suppression des contacts de la liste des destinataires"

4 Cliquez sur [Enregistrer (Save)].

Les contacts sont ajoutés comme destinations.
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Recherche de destinataires sur le serveur LDAP

Suivez la procédure ci-après pour rechercher des destinataires sur le serveur LDAP.

Conseil

Pour rechercher des destinataires dans le serveur LDAP, un administrateur doit configurer le service d'annuaire en 
utilisant TopAccess en mode d'administration. Pour plus d'informations, reportez-vous au Guide de TopAccess.

1 Cliquez sur [Configurer la destination (Destination Setting)] pour accéder à la page Liste des 
destinataires.

2 Cliquez sur [Rechercher (Search)].

La page Rechercher un contact apparaît.

3 Spécifiez une condition de recherche, puis cliquez sur [Rechercher (Search)].
Sélectionnez le nom du service d'annuaire à rechercher dans la boîte [Nom du service d'annuaire (Directory 
Service Name)], puis saisissez les termes recherchés dans les champs appropriés.

TopAccess commence la recherche des destinataires sur le serveur LDAP et la page Rechercher la liste des 
adresses affiche les résultats.

Conseil

 Si vous sélectionnez le nom de votre système dans la liste déroulante [Nom du service d'annuaire (Directory 
Service Name)], la recherche s'effectuera dans le répertoire téléphonique du système.

 TopAccess va rechercher les destinataires correspondant aux informations que vous avez saisies.
 Renseignez au moins un champ pour lancer une recherche approximative.
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4 Dans la colonne E-mail, activez les cases à cocher des utilisateurs que vous voulez ajouter et 
cliquez sur [Ajouter (Add)].

Les destinataires sélectionnés sont ajoutés à la page Liste des destinataires.

Conseil

Vous pouvez supprimer les contacts ajoutés à la liste des destinataires avant d'enregistrer les paramètres de 
destination.
 P.74 "Suppression des contacts de la liste des destinataires"

5 Cliquez sur [Enregistrer (Save)].

Les contacts sont ajoutés comme destinations.

Suppression des contacts de la liste des destinataires

1 Activez les cases des contacts à supprimer de la liste des destinataires et cliquez sur [Effacer 
(Delete)].

Les contacts sélectionnés sont supprimés de la liste des destinataires.
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 Edition des pages de vos documents    75

0.Edition des pages de vos documents

L'utilitaire Web e-Filing permet de modifier les documents stockés avant de les imprimer.
Il comporte trois boutons de commande : [Modifier (Edit)], [Enregistrer (Save)] et [Annuler (Cancel)].
Ces boutons s'affichent en haut du volet Contenu lorsque vous sélectionnez un document dans le volet Document. 
Les boutons affichés varient en fonction de l'état du document.

 [Modifier (Edit)] — Cliquez sur ce bouton pour modifier le document. Ce bouton apparaît uniquement en mode 
d'affichage, lorsque l'état du document indique "Affichage". Lorsque vous cliquez sur [Modifier (Edit)], l'état du 
document devient "Modifier", les boutons [Enregistrer (Save)] et [Annuler (Cancel)] se substituent au bouton 
[Modifier (Edit)] et vous pouvez modifier le document. Si vous cliquez sur ce bouton alors que l'état du document 
est "En cours d'utilisation", vous ne pouvez pas passer en mode d'édition et le message "Le document est en cours 
d'utilisation. Recommencez plus tard" apparaît.

 [Enregistrer (Save)] — Cliquez sur ce bouton pour enregistrer le document que vous avez modifié. Ce bouton est 
uniquement visible en mode d'édition, lorsque l'état du document est "Modification". Lorsque vous cliquez sur ce 
bouton, le document est enregistré et le mode d'affichage est rétabli.

 [Annuler (Cancel)] — Cliquez sur ce bouton pour revenir en mode d'affichage sans enregistrer le document. Ce 
bouton est uniquement visible en mode d'édition, lorsque l'état du document est "Modification".

L'état du document est indiqué à gauche de ces boutons. Les différents états sont :

 En cours d'utilisation — Indique que le document est en cours de modification par un autre utilisateur.
 Affichage — Indique que le document est en mode d'affichage. Celui-ci ne permet que de visualiser les pages du 

document.
 Modification — Indique que vous pouvez modifier le document.

Lorsque vous modifiez ou supprimez un document que vous partagez avec d'autres utilisateurs, n'oubliez pas de 
rafraîchir l'affichage pour voir l'état réel du document. Si plusieurs utilisateurs modifient ou suppriment 
simultanément le document et ses pages, certaines données risquent d'être endommagées.

L'utilitaire Web e-Filing permet de copier, de déplacer, de supprimer et d'insérer des pages dans les documents, ainsi 
que d'en modifier l'ordre.
 P.76 "Affichage des propriétés des documents et des pages"
 P.77 "Copie de pages d'un document à un autre"
 P.82 "Copie des pages d'un document dans une boîte ou un dossier"
 P.85 "Suppression de pages dans un document"
 P.87 "Insertion d'une page vierge dans un document"
 P.90 "Déplacement de pages dans un document"
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 Affichage des propriétés des documents et des pages
Vous pouvez afficher les fenêtres des propriétés du document et de la page pour en connaître le détail. Pour afficher la 
fenêtre des propriétés d'un document, activez la case à cocher de ce document et sélectionnez [Propriétés 
(Properties)] dans le menu [Fichier (File)]. Pour afficher la fenêtre des propriétés d'une page, activez la case à cocher 
de la page et sélectionnez [Propriétés (Properties)] dans le menu [Fichier (File)].

La fenêtre des propriétés du document contient les informations suivantes :

 Emplacement
Affiche le dossier dans lequel se trouve le document.

 Total page(s)
Affiche le nombre de pages du document.

 Format
Affiche la taille des données du document.

 Créé le
Affiche la date et l'heure de création du document.

 Modifié(e)
Affiche la date et l'heure de la dernière modification du document.

 Dernier accès
Affiche la date et l'heure auxquelles le document a été ouvert pour la dernière fois.

 [OK]
Cliquez sur ce bouton pour fermer la fenêtre.

La fenêtre des propriétés de la page contient les informations suivantes :

 Format
Affiche le mode dans lequel la page a été enregistrée.

 Résolution
Affiche la résolution de la page.

 Format de l'image
Affiche la taille en pixels de la page.

 Format papier
Affiche le format de papier de la page.

 Format
Affiche la taille des données de la page.

 [OK]
Cliquez sur ce bouton pour fermer la fenêtre.
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 Copie de pages d'un document à un autre
Vous pouvez copier ou couper des pages d'un document et les insérer dans un autre.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document dont vous souhaitez copier ou couper des pages.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Dans le volet Document, sélectionnez le document dont vous souhaitez copier ou couper des 
pages.

Les pages du document apparaissent dans le volet Contenu.

Conseil

Si vous souhaitez couper des pages du document, cliquez sur [Modifier (Edit)] pour passer en mode d'édition. En 
cliquant sur [Modifier (Edit)], vous faites passer le document du mode d'affichage au mode d'édition et vous 
pouvez ainsi couper des pages du document.

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant 
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cochez les pages que vous souhaitez copier ou couper, puis sélectionnez [Modifier (Edit)] > 
[Copier (Copy)] ou [Couper (Cut)].

 Si vous choisissez de couper des pages, passez à l'étape suivante à la fin de votre opération.

 Si vous choisissez de copier des pages, passez à l'étape 7 à la fin de votre opération.

Si l'utilitaire Web e-Filing est en train d'effectuer une tâche, attendez qu'il ait fini.

5 Cliquez sur [Enregistrer (Save)].

La fenêtre d'enregistrement du document apparaît.

6 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

 Si vous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son 
nom, le document sera écrasé.

 Le document passe du mode d'édition au mode d'affichage.

Ne fermez pas la fenêtre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de 
provoquer un dysfonctionnement du système. Si vous fermez la fenêtre en cliquant sur [X] par erreur, mettez le 
système hors tension avant de le remettre sous tension.
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7 Dans le volet Document, sélectionnez le répertoire ou le dossier contenant le document dans 
lequel vous souhaitez insérer les pages copiées.

8 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

9 Dans le volet Document, sélectionnez le document dans lequel vous souhaitez insérer les pages 
copiées, puis cliquez sur [Modifier (Edit)].

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode 
d'édition.

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant 
donné qu'un autre utilisateur travaille actuellement sur ce document.
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10Cliquez sur l'espace entre les pages où vous souhaitez insérer les pages copiées.

Les indicateurs de direction se déplacent alors vers l'espace sur lequel vous avez cliqué.

11Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

Les pages copiées sont insérées entre les pages spécifiées.

12Cliquez sur [Enregistrer (Save)].

La fenêtre d'enregistrement du document apparaît.
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13Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

 Si vous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son 
nom, le document sera écrasé.

 Le document passe du mode d'édition au mode d'affichage.

Ne fermez pas la fenêtre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de 
provoquer un dysfonctionnement du système. Si vous fermez la fenêtre en cliquant sur [X] par erreur, mettez le 
système hors tension avant de le remettre sous tension.
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 Copie des pages d'un document dans une boîte ou un dossier
Vous pouvez copier ou couper des pages d'un document et les enregistrer dans une boîte ou un dossier en tant que 
nouveau document.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document dont vous souhaitez copier ou couper des pages.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Dans le volet Document, sélectionnez le document dont vous souhaitez copier ou couper des 
pages.

Les pages du document apparaissent dans le volet Contenu.

Conseil

Si vous souhaitez couper des pages du document, cliquez sur [Modifier (Edit)] pour passer en mode d'édition. En 
cliquant sur [Modifier (Edit)], vous faites passer le document du mode d'affichage au mode d'édition et vous 
pouvez ainsi couper des pages du document.

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant 
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cochez les pages que vous souhaitez copier ou couper, puis sélectionnez [Modifier (Edit)] > 
[Copier (Copy)] ou [Couper (Cut)].

 Si vous choisissez de couper des pages, passez à l'étape suivante à la fin de votre opération.

 Si vous choisissez de copier des pages, passez à l'étape 7 à la fin de votre opération.

Si l'utilitaire Web e-Filing est en train d'effectuer une tâche, attendez qu'il ait fini.

5 Cliquez sur [Enregistrer (Save)].

La fenêtre d'enregistrement du document apparaît.

6 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

 Si vous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son 
nom, le document sera écrasé.

 Le document passe du mode d'édition au mode d'affichage.

Ne fermez pas la fenêtre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de 
provoquer un dysfonctionnement du système. Si vous fermez la fenêtre en cliquant sur [X] par erreur, mettez le 
système hors tension avant de le remettre sous tension.
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7 Dans le volet Document, sélectionnez le répertoire ou le dossier dans lequel vous souhaitez 
stocker les pages copiées.

8 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

9 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

Le document contenant les pages copiées est créé dans le répertoire ou le dossier sélectionné.
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 Suppression de pages dans un document
Vous pouvez supprimer les pages d'un document.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document dont vous souhaitez supprimer des pages.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Dans le volet Document, sélectionnez le document dans lequel vous souhaitez supprimer des 
pages, puis cliquez sur [Modifier (Edit)].

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode 
d'édition.

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant 
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cochez les pages que vous souhaitez supprimer, puis sélectionnez [Modifier (Edit)] > [Supprimer 
(Delete)].

La boîte de dialogue de confirmation apparaît.

5 Cliquez sur [OK].

Les pages sélectionnées sont supprimées.

6 Cliquez sur [Enregistrer (Save)].

La fenêtre d'enregistrement du document apparaît.

7 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

 Si vous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son 
nom, le document sera écrasé.

 Le document passe du mode d'édition au mode d'affichage.

Ne fermez pas la fenêtre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de 
provoquer un dysfonctionnement du système. Si vous fermez la fenêtre en cliquant sur [X] par erreur, mettez le 
système hors tension avant de le remettre sous tension.
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 Insertion d'une page vierge dans un document
Vous pouvez insérer des pages vierges dans un document et sélectionner un format différent pour chacune d'elles.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document dans lequel vous souhaitez insérer une page blanche.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Dans le volet Document, sélectionnez le document dans lequel vous souhaitez insérer une page 
blanche, puis cliquez sur [Modifier (Edit)].

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode 
d'édition.

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant 
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cliquez sur l'espace entre les pages où vous souhaitez insérer une page vierge.

Les indicateurs de direction se déplacent alors vers l'espace sur lequel vous avez cliqué.

5 Sélectionnez [Mise en page (Layout)] > [Insérer une page vierge (Insert Blank Page)].

La fenêtre Insérer une page vierge apparaît.

6 Sélectionnez le format de papier et l'orientation de la page vierge insérée et cliquez sur [OK].

Une page vierge est insérée entre les pages spécifiées.

Conseil

Sa taille diffère selon le modèle.
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7 Cliquez sur [Enregistrer (Save)].

La fenêtre d'enregistrement du document apparaît.

8 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

 Si vous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son 
nom, le document sera écrasé.

 Le document passe du mode d'édition au mode d'affichage.

Ne fermez pas la fenêtre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de 
provoquer un dysfonctionnement du système. Si vous fermez la fenêtre en cliquant sur [X] par erreur, mettez le 
système hors tension avant de le remettre sous tension.
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 Déplacement de pages dans un document
Vous pouvez modifier l'organisation des pages dans un document.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document dont vous souhaitez réorganiser des pages.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Dans le volet Document, sélectionnez le document dans lequel vous souhaitez déplacer des 
pages, puis cliquez sur [Modifier (Edit)].

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode 
d'édition.

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant 
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cochez les pages que vous souhaitez déplacer, puis sélectionnez [Modifier (Edit)] > [Couper 
(Cut)].

Les pages sélectionnées sont copiées dans le presse-papier et supprimées du document.

Si l'utilitaire Web e-Filing est en train d'effectuer une tâche, attendez qu'il ait fini.

5 Cliquez sur l'espace entre les pages où vous souhaitez insérer les pages copiées.

Les indicateurs de direction se déplacent alors vers l'espace sur lequel vous avez cliqué.

6 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

Les pages copiées sont insérées entre les pages spécifiées.

7 Poursuivez la procédure décrite aux étapes 4 à 6 pour réorganiser les pages.
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8 Une fois la réorganisation terminée, cliquez sur [Enregistrer (Save)].

La fenêtre d'enregistrement du document apparaît.

9 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

 Si vous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son 
nom, le document sera écrasé.

 Le document passe du mode d'édition au mode d'affichage.

Ne fermez pas la fenêtre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de 
provoquer un dysfonctionnement du système. Si vous fermez la fenêtre en cliquant sur [X] par erreur, mettez le 
système hors tension avant de le remettre sous tension.
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0.Déplacement et fusion de documents

Vous pouvez non seulement déplacer des documents entre les répertoires et les dossiers, mais également combiner 
plusieurs documents en un seul.
 P.93 "Déplacement de documents"
 P.95 "Fusion de documents"

 Déplacement de documents
Vous pouvez déplacer des documents d'une boîte ou d'un dossier à un(e) autre, par exemple afin de simplifier la 
gestion des documents.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant le 
document que vous souhaitez déplacer.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Cochez les documents que vous souhaitez déplacer, puis sélectionnez [Modifier (Edit)] > [Couper 
(Cut)].

Les documents sélectionnés sont copiés dans le presse-papiers et supprimés de la boîte ou du dossier en cours.

Si l'utilitaire Web e-Filing est en train d'effectuer une tâche, attendez qu'il ait fini.
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4 Dans le volet Document, sélectionnez la boîte ou le dossier dans lequel vous souhaitez coller les 
documents.

5 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

6 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

Les documents sont créés dans le répertoire ou le dossier sélectionné(e).
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 Fusion de documents
Vous pouvez copier toutes les pages d'un document et les insérer dans un autre.
Le document que vous souhaitez insérer est appelé document source. Le document dans lequel vous souhaitez 
intégrer le document source est le document cible.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boîte ou le dossier contenant les 
documents source.

2 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

3 Cochez les documents sources, puis sélectionnez [Modifier (Edit)] > [Copier (Copy)].

Les documents sélectionnés sont copiés dans le presse-papiers.

Si l'utilitaire Web e-Filing est en train d'effectuer une tâche, attendez qu'il ait fini.
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4 Dans le volet Document, sélectionnez la boîte ou le dossier contenant le document de 
destination.

5 Si vous avez sélectionné une boîte protégée par un mot de passe, la fenêtre d'authentification 
par mot de passe apparaît. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous 
connecter pendant une certaine période car cela sera considéré comme un accès non autorisé. Lorsque "La boîte 
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de 
passe de la boîte (Box Password)].

6 Dans le volet Document, sélectionnez le document de destination, puis cliquez sur [Modifier 
(Edit)].

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode 
d'édition.

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant 
donné qu'un autre utilisateur travaille actuellement sur ce document.
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7 Cliquez sur l'espace entre les pages où vous souhaitez fusionner les documents.

Les indicateurs de direction se déplacent alors vers l'espace sur lequel vous avez cliqué.

8 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

Les documents copiés sont fusionnés entre les pages spécifiés.

9 Cliquez sur [Enregistrer (Save)].

La fenêtre d'enregistrement du document apparaît.
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10Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

 Si vous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son 
nom, le document sera écrasé.

 Le document passe du mode d'édition au mode d'affichage.

Ne fermez pas la fenêtre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de 
provoquer un dysfonctionnement du système. Si vous fermez la fenêtre en cliquant sur [X] par erreur, mettez le 
système hors tension avant de le remettre sous tension.
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Cette section est destinée aux administrateurs des systèmes. Les utilisateurs généraux n'ont pas besoin de la lire.
Elle décrit la fonction administration système de l'e-Filing.

Administration système .................................................................................................. 100
Connexion en tant qu'administrateur système................................................................................................100
A propos de l'écran administrateur ..................................................................................................................101
Gestion du périphérique de stockage interne dans e-Filing............................................................................102



100    Administration système

0.Administration système

Cette section décrit l'administration système des fonctions e-Filing.
 P.100 "Connexion en tant qu'administrateur système"
 P.101 "A propos de l'écran administrateur"
 P.102 "Gestion du périphérique de stockage interne dans e-Filing."

 Connexion en tant qu'administrateur système
Pour vous connecter en tant qu'administrateur système, lancez l'utilitaire Web e-Filing et suivez la procédure ci-
dessous.

"Administrateur système" et "Utilisateur disposant des droits d'administration" sont définis comme suit dans ce 
manuel.

 Administrateur système : 
Utilisateur avec le rôle d'administrateur

 Utilisateur disposant des droits d'administration 
Utilisateur dont l'ID est "Admin"

1 Cliquez sur le lien Connexion situé dans l'angle supérieur droit de la page.

La page Connexion administrateur s'ouvre.

2 Saisissez le mot de passe de l'administrateur, puis cliquez sur [Connexion (Login)].

L'onglet [Administration] apparaît dans les onglets principaux.

 Si vous entrez plusieurs fois un mot de passe d'authentification incorrect pour vous connecter à l'utilitaire 
Web e-Filing en mode administrateur, vous ne pourrez pas vous connecter pendant un certain temps car cela 
sera considéré comme un accès non autorisé.

 Pour empêcher son accès non autorisé par d'autres utilisateurs, cliquez sur le lien de déconnexion et assurez-
vous de fermer votre navigateur lorsque vous vous déconnectez de l'utilitaire Web e-Filing en mode 
administrateur.

Conseil

Le mot de passe de l'administrateur est identique à celui défini dans TopAccess ou sur l'écran tactile. Par défaut, 
le mot de passe de l'administrateur est "123456".
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 A propos de l'écran administrateur
L'onglet [Administration] permet à l'administrateur système de gérer les données e-Filing. Il est visible uniquement 
lorsque vous vous connectez en tant qu'administrateur système.
 P.101 "Page [Gestion de la boîte (Box Management)]"

Conseil

L'administrateur peut également paramétrer les notifications pour e-Filing à l'aide de TopAccess en mode 
administrateur. Pour plus d'informations sur le paramétrage des notifications pour e-Filing, reportez-vous au Guide 
de TopAccess.

 Page [Gestion de la boîte (Box Management)]

Cette page permet de supprimer manuellement les zones utilisateur inutiles ou corrompues. Utilisez cette option 
pour restaurer l'espace disponible du périphérique de stockage interne. Vous pouvez également débloquer les 
répertoires utilisateurs verrouillés suite à la saisie de mots de passe erronés.

1. Espace disque disponible
Cette zone indique l'espace disponible du périphérique de stockage interne pour le stockage des données dans 
e-Filing.

2. N° de la boîte / Nom de la boîte / Capacité utilisée / Etat
Cette option permet d'afficher la liste de tous les répertoires utilisateur. Lorsque vous cliquez sur le lien du 
numéro ou du nom du répertoire, la fenêtre des propriétés du répertoire s'ouvre et indique les propriétés 
détaillées du répertoire. L'état d'une zone utilisateur verrouillée s'affiche dans les résultats. 
Pour supprimer ou déverrouiller un répertoire utilisateur, cochez la case à gauche de chaque propriété, puis 
cliquez sur [Supprimer (Delete)] ou [Déverrouiller (Unlock)].

3. [Supprimer (Delete)]
Cliquez sur ce bouton pour supprimer les répertoires sélectionnés. Au préalable, cochez les cases des zones 
utilisateur que vous souhaitez supprimer.

Conseil

 Il est impossible de supprimer un répertoire public.
 Pour plus d'informations sur l'effacement des répertoires utilisateur, reportez-vous à la section suivante :
 P.102 "Effacement des données dans les répertoires"

4. [Déverrouiller (Unlock)]
Cliquez sur ce bouton pour déverrouiller les répertoires sélectionnés. Au préalable, cochez les cases des zones 
utilisateur que vous souhaitez déverrouiller.

Conseil

Pour plus d'informations sur le déverrouillage des répertoires utilisateur, reportez-vous à la section suivante :
 P.103 "Déverrouillage des répertoires utilisateur"

1

3
4

2
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 Gestion du périphérique de stockage interne dans e-Filing.
Un administrateur doit régulièrement contrôler les données stockées dans les dossiers e-Filing afin de garantir un 
espace du périphérique de stockage interne suffisant pour les opérations quotidiennes.
Les administrateurs peuvent gérer les boîtes, dossiers et documents de la même manière que les utilisateurs 
généraux. Pour plus de détails sur cette opération, reportez-vous à la section ci-dessous.
 P.40 "Gestion des répertoires et des dossiers utilisateur"
 P.50 "Gestion de documents"
Cette section décrit la fonction d'administrateur qui vous permet de supprimer les répertoires et la méthode de 
déverrouillage des répertoires utilisateur verrouillés à la suite de saisies incorrectes du mot de passe.
 P.102 "Effacement des données dans les répertoires"
 P.103 "Déverrouillage des répertoires utilisateur"

 Effacement des données dans les répertoires

Vous pouvez effacer manuellement les champs contenus dans e-Filing dont les données ont été altérées (suite à une 
défaillance du périphérique de stockage interne, par exemple) et qui sont devenus inutilisables.

1 Connectez-vous à la page Administrateur.
 P.100 "Connexion en tant qu'administrateur système"
La page Gestion des dossiers apparaît.

 Avant de supprimer les répertoires, il est recommandé d'archiver les documents qui y sont contenus. Une fois 
les répertoires supprimés, vous ne pouvez plus restaurer les documents.
 P.62 "Archivage de documents"

 L'utilitaire de sauvegarde/restauration inclus dans le DVD Utilitaires client/Documentation utilisateur vous 
permet de sauvegarder les données contenues dans les boîtes.

Conseil

Vous pouvez afficher la fenêtre des propriétés du répertoire en cliquant sur le lien du numéro ou du nom du 
répertoire.

2 Cochez les cases des répertoires utilisateur à supprimer et cliquez sur [Supprimer (Delete)].

La boîte de dialogue de confirmation apparaît.

Conseil

Pour plus d'informations sur la page Gestion de la boîte, reportez-vous à la section suivante :
 P.101 "Page [Gestion de la boîte (Box Management)]"
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3 Cliquez sur [OK].

Les répertoires utilisateur sélectionnés sont supprimés de e-Filing.

 Déverrouillage des répertoires utilisateur

Lorsque le paramètre Verrouillage de e-Filing est défini sur “Activer” dans la police de mot de passe, si un mot de 
passe erroné est saisi consécutivement un nombre de fois spécifié, le répertoire utilisateur est verrouillé et ne peut 
pas être utilisé pendant un certain temps. L'administrateur du système a la possibilité de déverrouiller les répertoires 
utilisateur qui ont été ainsi verrouillés.

La police de mot de passe peut être définie dans TopAccess. Pour plus d'informations sur la police de mot de passe, 
reportez-vous au Guide de TopAccess.

1 Connectez-vous à la page Administrateur.
 P.100 "Connexion en tant qu'administrateur système"
La page Gestion des dossiers apparaît.

Conseil

 Pour les répertoires utilisateur verrouillés, le champ État affiche “Verrouillé”.
 Vous pouvez afficher la fenêtre des propriétés du répertoire en cliquant sur le lien du numéro ou du nom du 

répertoire.

2 Cochez la case du répertoire utilisateur à déverrouiller, puis cliquez sur [Déverrouiller (Unlock)].

Le verrouillage du répertoire utilisateur sélectionné est supprimé.

Conseil

Pour plus d'informations sur la page Gestion de la boîte, reportez-vous à la section suivante :
 P.101 "Page [Gestion de la boîte (Box Management)]"
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